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Legal information
Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger.

 
DANGER

indicates that death or severe personal injury will result if proper precautions are not taken.
 

 
WARNING

indicates that death or severe personal injury may result if proper precautions are not taken.
 

 
CAUTION

indicates that minor personal injury can result if proper precautions are not taken.
 

 
NOTICE
indicates that property damage can result if proper precautions are not taken.
If more than one degree of danger is present, the warning notice representing the highest degree of danger will be 
used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property 
damage.

Qualified Personnel
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. Qualified 
personnel are those who, based on their training and experience, are capable of identifying risks and avoiding 
potential hazards when working with these products/systems.

Proper use of Siemens products
Note the following:

 
WARNING

Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended or 
approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication 
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability
We have reviewed the contents of this publication to ensure consistency with the hardware and software described. 
Since variance cannot be precluded entirely, we cannot guarantee full consistency.  However, the information in 
this publication is reviewed regularly and any necessary corrections are included in subsequent editions.

 Siemens AG
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Postfach 48 48
90026 NÜRNBERG
GERMANY

A5E32316269-AB
Ⓟ 08/2013 Technical data subject to change

Copyright © Siemens AG 2013.
All rights reserved



Table of contents

1 WinCC/WebNavigator Installation Notes......................................................................................................7
 1.1 General information.......................................................................................................................7
 1.2 Requirements................................................................................................................................8
 1.2.1 Hardware and Software.................................................................................................................8
 1.2.2 Licensing.....................................................................................................................................10
 1.2.3 Requirements for the Use of Terminal Services..........................................................................12
 1.3 Installing a WebNavigator server.................................................................................................14
 1.3.1 Overview......................................................................................................................................14
 1.3.2 Installing the Internet Information Server (IIS).............................................................................15
 1.3.3 Installing the WebNavigator server..............................................................................................16
 1.4 Installing the WebNavigator client...............................................................................................18
 1.4.1 Installing the WebNavigator client...............................................................................................18
 1.4.2 User rights, user groups and optional installation possibilities....................................................20
 1.4.3 Internet Explorer Settings............................................................................................................23
 1.4.4 Installation from the DVD.............................................................................................................23
 1.4.5 Installation via the Intranet/Internet.............................................................................................24
 1.5 Installing the WebNavigator diagnostics client............................................................................26
 1.6 WebNavigator Demo Project.......................................................................................................27
 1.7 Deinstallation...............................................................................................................................28

2 WinCC/WebNavigator Release Notes........................................................................................................29
 2.1 Information about WebNavigator.................................................................................................29
 2.2 Service and Support....................................................................................................................34
 2.2.1 Warnings.....................................................................................................................................34
 2.2.2 Customer Support.......................................................................................................................36
 2.2.3 Support Request..........................................................................................................................38

3 WinCC/WebNavigator Getting Started.......................................................................................................41
 3.1 First Web Project.........................................................................................................................41
 3.2 Configuring the WinCC project....................................................................................................43
 3.2.1 Publishing process pictures.........................................................................................................43
 3.2.2 Administering the users for WebNavigator Client........................................................................49
 3.3 Configuring the WebNavigator Server.........................................................................................51
 3.3.1 Starting the demo project............................................................................................................51
 3.3.2 Configuring the WebNavigator web page....................................................................................51
 3.3.3 Configuring the Firewall...............................................................................................................53
 3.3.3.1 Configuring the Firewall in Windows XP/Windows 2003.............................................................53
 3.3.3.2 Configuring the Firewall in Windows 7/Windows 2008................................................................58
 3.3.4 Check the activated web page....................................................................................................59
 3.4 Operating the WinCC project.......................................................................................................61
 3.4.1 Operating the WinCC project with Internet Explorer....................................................................61

WinCC/WebNavigator
System Manual, 07/2013, A5E32316269-AB 3



 3.4.1.1 Internet Explorer Settings............................................................................................................61
 3.4.1.2 Installing the WebNavigator Client..............................................................................................62
 3.4.2 Operating the WinCC project using WinCCViewerRT.................................................................63
 3.4.2.1 Configuring WinCCViewerRT......................................................................................................63
 3.4.2.2 Operating the WinCC project.......................................................................................................67
 3.5 Creating a new process picture and displaying it on the client....................................................69
 3.5.1 Creating a new process picture...................................................................................................69
 3.5.2 Configuring a new process picture for the web...........................................................................71
 3.5.3 Displaying the process picture on the WebNavigator Client........................................................72

4 WinCC/WebNavigator Documentation.......................................................................................................75
 4.1 Function overview........................................................................................................................75
 4.2 Possible applications of WinCC/WebNavigator...........................................................................77
 4.2.1 WebNavigator Server on the WinCC Server...............................................................................77
 4.2.2 Separation of the WinCC and WebNavigator servers.................................................................78
 4.2.3 Dedicated Web Server................................................................................................................80
 4.2.4 WinCCViewerRT.........................................................................................................................82
 4.2.5 WebNavigator Diagnostics Client................................................................................................82
 4.2.6 Terminal services and WebNavigator..........................................................................................83
 4.3 Configuring the WebNavigator system........................................................................................84
 4.3.1 Overview of the configuration steps............................................................................................84
 4.3.2 Configuring the WinCC project....................................................................................................85
 4.3.2.1 Publishing WinCC process pictures............................................................................................85
 4.3.2.2 Configuring web settings.............................................................................................................95
 4.3.2.3 Administering the users for WebNavigator Client......................................................................100
 4.3.3 Configuring the WebNavigator Server.......................................................................................103
 4.3.3.1 Configuring the WebNavigator web page..................................................................................103
 4.3.3.2 Load Distribution Using the "Load Balancing" Function............................................................115
 4.3.4 Differences to the WinCC Basic System...................................................................................121
 4.3.4.1 Functional restrictions................................................................................................................121
 4.3.4.2 Using Scripts.............................................................................................................................122
 4.3.4.3 Using tags..................................................................................................................................124
 4.4 Operating the WinCC project.....................................................................................................125
 4.4.1 General properties of the WebNavigator Client.........................................................................125
 4.4.2 Process pictures on the WebNavigator Client...........................................................................127
 4.4.3 Operating the WinCC project with Internet Explorer..................................................................129
 4.4.3.1 Operating the WinCC project with Internet Explorer..................................................................129
 4.4.3.2 Working with the WinCC Web Navigation interface..................................................................130
 4.4.3.3 Expanding the WinCC Web Navigation interface......................................................................131
 4.4.3.4 Diagnosis of the Connections with "Status.html".......................................................................132
 4.4.4 Operating the WinCC project using WinCCViewerRT...............................................................134
 4.4.4.1 Configuring WinCCViewerRT....................................................................................................134
 4.4.4.2 Operating the WinCC project.....................................................................................................138
 4.4.5 Using the "Hardcopy" function...................................................................................................139
 4.5 Installation of the WinCC Plug-In Builder..................................................................................141
 4.5.1 Overview of the WinCC Plug-In Builder.....................................................................................141
 4.5.2 How to make plug-ins available for download...........................................................................143
 4.6 Configuring terminal services for WebNavigator.......................................................................145
 4.6.1 Communication Using Terminal Services..................................................................................145

Table of contents

WinCC/WebNavigator
4 System Manual, 07/2013, A5E32316269-AB



 4.6.2 Terminal Services Setup...........................................................................................................145
 4.6.3 Activating terminal services on the Windows Server.................................................................146
 4.6.4 Creating users for access to the Terminal Server.....................................................................146
 4.6.5 Starting the Terminal Server on the Terminal Client.................................................................147
 4.7 Appendix....................................................................................................................................148
 4.7.1 Troubleshooting.........................................................................................................................148
 4.7.2 Functions...................................................................................................................................150
 4.7.2.1 Supported functions...................................................................................................................150
 4.7.2.2 WaitForDocumentReady...........................................................................................................158
 4.7.2.3 Unsupported Functions.............................................................................................................160

 Index.........................................................................................................................................................163

Table of contents

WinCC/WebNavigator
System Manual, 07/2013, A5E32316269-AB 5





WinCC/WebNavigator Installation Notes 1
1.1 General information

Software Information Service         
If you return the "WinCC Software Information Service" card, you will receive the latest 
information on all SIMATIC WinCC products.

Information about licensing terms
Please observe the license conditions which appear during the installation process. Please 
contact your Siemens AG representative for additional information.

Contents of the WinCC DVD for WinCC/WebNavigator
● WebNavigator server

● WebNavigator client

● WinCCViewerRT

● WebNavigator diagnostics client

● Web View Publisher

● WebNavigator Plug-In Builder

● Documentation

● Release notes
 

 Note
Installation of WinCC/WebNavigator V7.2 is only released on the basis of WinCC V7.2

You cannot install the WebNavigator server/client of V7.2 on a computer with WinCC versions 
earlier than V7.2. Nor can a WebNavigator server/client version older than V7.2 be installed 
on a computer with WinCC V7.2.

Note that mixed use of European and Asian versions of WinCC and WebNavigator is not 
permitted in the configuration.
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1.2 Requirements

1.2.1 Hardware and Software

Introduction                             
This section describes the hardware and operating system requirements for WinCC/
WebNavigator. 

 

 Note

A WebNavigator server cannot be operated on a WinCC client without a project of its own.
 

WebNavigator client

Table 1-1 Hardware

 Minimum Recommended
CPU Pentium II; 300 MHz E.g. Intel Core 2 Duo, AMD Athlon64 or 

higher
RAM 256 MB 1 GB

Table 1-2 Software 

Operating system Windows 7 SP1 32-bit
Windows XP Professional SP3
Windows Server 2008 Standard SP2 32-bit
Windows Server 2008 R2 Standard SP1 64-bit
Windows Server 2003 Standard SP2
Windows Server 2003 R2 Standard SP2
Via MS Terminal Services, also other operating systems such as WinCE, Win95
Windows XP Embedded in connection with Panel PC 477

Software Internet Explorer as of V7.0
If you want to use .NET and XAML controls, you will need to install .NET Framework 3.0.

Other Access to the intranet/Internet
or a TCP/IP connection to the WebNavigator server 

Operation of the WebNavigator client via Wireless LAN has only been approved with SIMATIC 
Mobile Panel PC 12"

WinCC/WebNavigator Installation Notes
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WebNavigator server on a WinCC single-user system 

Table 1-3 Hardware

 Minimum Recommended
CPU Pentium III; 1 GHz E.g. Intel Core 2 Duo, AMD Athlon64 or 

higher
RAM 1 GB 2 GB

Table 1-4 Software

Operating system Windows 7 SP1 32-bit
Windows XP Professional SP3 (max. 3 clients)
Windows Server 2008 Standard SP2 32-bit
Windows Server 2008 R2 Standard SP1 64-bit
Windows Server 2003 Standard SP2
Windows Server 2003 R2 Standard SP2

Software Internet Explorer as of V7.0
WinCC Basic System V7.2

Other Access to the intranet/Internet 
or a TCP/IP connection to the WebNavigator client 

WebNavigator server on WinCC server or WinCC client with its own project

Table 1-5 Hardware

 Minimum Recommended
CPU Pentium III; 1 GHz E.g. Intel Core 2 Duo, AMD Athlon64 or 

higher
RAM 1 GB > 1 GB

Table 1-6 Software

Operating system Windows Server 2008 Standard SP2 32-bit
Windows Server 2008 R2 Standard SP1 64-bit
Windows Server 2003 Standard SP2
Windows Server 2003 R2 Standard SP2

Software Internet Explorer as of V7.0
WinCC Basic System V7.2

Other Access to Intranet/Internet
If you wish to publish on the Intranet , you will need a system that converts computer names into 
IP addresses. This step allows users to use alias names instead of IP addresses when connecting 
to the server.
You will need DNS registration for your IP address if you wish to publish on the Internet . This step 
allows users to use alias names instead of IP addresses when connecting to the server.
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WebNavigator diagnostics client

Table 1-7 Software

Operating system Windows 7 SP1 32-bit
Windows XP Professional SP3
Windows Server 2008 Standard SP1 32-bit
Windows Server 2008 R2 Standard SP2 64-bit
Windows Server 2003 Standard SP2 
Windows Server 2003 R2 Standard SP2

Software Internet Explorer as of V7.0 
Other Access to Intranet/Internet

1.2.2 Licensing

WebNavigator client    
No license is required for the PC on which the WebNavigator client is running, as server 
licenses are available on the WebNavigator server. 

WebNavigator server
As a prerequisite for the WinCC basic system, the WinCC RT basic license is required. No 
WinCC server license is required if no local WinCC clients are to be operated. Even when 
operating a WinCC client as a dedicated web server, you do not require a WinCC server license 
for the WinCC client. 

Without license, WebNavigator server will run in demo mode for 30 days.
However, you need a license to use WebNavigator server on a permanent basis. Licenses are 
available for 1 / 3 / 5 / 10 / 25 / 50 clients that can simultaneously access the WebNavigator 
server. 

A message will appear if the number of licensed clients is exceeded during a login attempt by 
a WebNavigator client. No further logins will be possible.

WebNavigator diagnostics client
A "Diagnostics client" license is required on the client computer for the diagnostics client. The 
diagnostics client can access up to 18 WebNavigator servers simultaneously. 

If a license for WebNavigator server or for WebNavigator diagnostics server is installed on the 
server, the diagnostics client will have access even if the maximum number of clients is 
exceeded.
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WebNavigator diagnostics server
This license allows the WebNavigator diagnostics client to access the WebNavigator server if 
there is no WebNavigator server license for WebNavigator clients installed on the 
WebNavigator server.

In total, simultaneous access to up to 50 diagnostics clients per server is permitted.

Overview of licenses for WebNavigator server and client

Server Client has no license Client has diagnostics client 
license 

WebNavigator server license + 
WinCC license

WebNavigator client 
To max. number of server 
licenses

Diagnostics client 
One license per diagnostics 
client

WebNavigator diagnostics server 
license + 
WinCC license

Demo client 
Unlimited number

Diagnostics client 
One license per diagnostics 
client

No WebNavigator license or 
no WinCC license

Demo client 
Unlimited number

Demo client 
Unlimited number

WebNavigator server license + 
WinCC license +
"Load Balancing" license

WebNavigator client 
To max. number of server 
licenses

Diagnostics client 
One license per diagnostics 
client

WebNavigator server license + 
WinCC license +
WinCC redundancy license +
"Load Balancing Step-Up" license

WebNavigator client 
To max. number of server 
licenses

Diagnostics client 
One license per diagnostics 
client

You can combine WebNavigator and diagnostics licenses.

Restarting the WebNavigator client after license modification
If the WebNavigator licenses on the WebNavigator server are modified, e.g. to a different 
number of clients, Internet Explorer must be restarted on each connected WebNavigator client, 
and the WebNavigator client must log in again. Otherwise, the WebNavigator client will switch 
to demo mode. This also applies to automatic reconnection of the WebNavigator client.

 

 Note
Diagnostics client without corresponding license

If the diagnostics client is installed without the respective license, a message will appear 
about one hour after each start-up of the computer. Install the diagnostics client license or 
remove the diagnostics client software.
Computer with WinCC basic system and diagnostics client

If you install a diagnostics client on a computer with the WinCC basic system, you will have 
to reinstall the diagnostics client after removing WinCC.
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1.2.3 Requirements for the Use of Terminal Services
The WebNavigator client is released for Windows Terminal Services. A maximum of 25 
sessions per terminal server are permitted.     

Terminal server

Table 1-8 Hardware

 Minimum Recommended
CPU Pentium III; 1 GHz E.g. Intel Core 2 Duo, AMD Athlon64
RAM 1 GB > 1 GB

 

 Note

Each terminal client will increase the memory requirements and the processor load. You must 
therefore ensure that the terminal server has adequate memory and processor load capacity. 

 

Table 1-9 Software

Operating system Windows Server 2008 SP2 32-bit or 64-bit
Server 2008 R2 SP2 64-bit
Windows Server 2003 SP2 or Server 2003 R2 SP2
It must be possible to repeatedly call and execute applications that 
are to be executed on the clients.

Other: If many users want to access the server, you will need to use a high-
performance network card. 

Terminal client

Minimum requirement: Network card with TCP/IP
Terminal client RDP 5.0
Display or monitor
Pointing device

 

 Note

As with Windows Server CAL, there are two different CAL terminal services:
● The TS device CAL enables a device to run user-independent Windows sessions on a 

Windows Server.
● The TS user CAL enables a user to run device-independent Windows sessions on a 

Windows Server.

A Windows Server Terminal Server CAL "TS CAL" is required for every user or every device. 

Please go to "http://www.microsoft.com/resources/sam/lic_cal.mspx" for more information.
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See also
http://www.microsoft.com/resources/sam/lic_cal.mspx (http://www.microsoft.com/resources/
sam/lic_cal.mspx)
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1.3 Installing a WebNavigator server

1.3.1 Overview

Requirements
● The software requirements for the Windows operating system have been met.

● Local administrator rights.

● The WinCC basic system is installed.

Installation Overview
1. Installation of the Internet Information Server (IIS).

2. Installation of the WebNavigator server.
 

  Note
WinCC options previously installed

If you have already installed other WinCC options prior to the installation of WinCC/
WebNavigator, you may have to re-install these options.

 

Installation sequence for the WebNavigator server for Windows 7 and Windows XP
Follow the installation sequence below when installing a WebNavigator server on a computer 
running Windows 7 or Windows XP:

1. Install the Internet Information Service (IIS).

2. Install the SQL server.

3. Start the "Web Configurator" in the Windows start menu by selecting "SIMATIC > WinCC 
> Web Configurator" and configure the WebNavigator server.

4. Start the Security Control in the Windows start menu by selecting "Programs  > Siemens 
Automation > Security Controller" and configure the security settings.

See also
Installing the Internet Information Server (IIS) (Page 15)

Installing the WebNavigator server (Page 16)
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1.3.2 Installing the Internet Information Server (IIS)

Settings       
Before installing the WebNavigator server, you must first install the Internet Information Service 
(IIS). You specify the settings for the WebNavigator server during installation.

Activate the following settings under Windows 7 and Windows Server 2008:

● Web management tools:

– IIS management service

– IIS management console

– IIS management scripts and tools

– Compatibility with IIS Metabasis and IIS 6 configuration

– Compatibility with WMI for IIS 6

● WWW services > General HTTP features:

– Standard document

– Static content

● WWW services > Application development features:

– ASP

– ISAPI extensions

– ISAPI filters

● WWW services > Security:

– Requirement filtering

– Standard authentication
 

  Note

If the logging functions are active with IIS, the log files must be monitored and deleted, 
if necessary. The event views should be configured so that the log files do not become 
too large.

 

Requirements
● Administrator rights

● Write access for the registration database

Procedure
1. Insert the Windows installation data medium into the drive.

2. From the Windows start menu, select the entry "Settings" > "Control Panel."

3. Click the "Software" icon.
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4. Open the "Add or Remove Programs" dialog and click "Add or Remove Windows 
Components". The wizard for Windows components will open.

5. Select the checkbox preceding the "Internet Information Service (IIS)" item in the selection 
window.

6. Activate the specified settings under Windows 7.

7. Close the dialog with the "OK" button. The required data is transferred and the IIS is 
configured accordingly.

Alternative procedure
Alternatively, you can use the command line "Start > Run > cmd" to install the IIS components 
located on the installation data medium:

pkgmgr.exe /iu:IIS-WebServerRole;IIS-WebServer;IIS-CommonHttpFeatures;IIS-
StaticContent;IIS-DefaultDocument;IIS-HttpErrors;IIS-ASPNET;IIS-ASP;IIS-
ISAPIExtensions;IIS-ISAPIFilter;IIS-BasicAuthentication;IIS-WindowsAuthentication;IIS-
ManagementConsole;IIS-ManagementService;IIS-IIS6ManagementCompatibility;IIS-
Metabase;IIS-WMICompatibility

Procedure for Windows Server 2008
Configure the settings for the Windows Server 2008 in the Server Manager via the role 
"Webserver (IIS)" in the associated role services.

1.3.3 Installing the WebNavigator server

Requirements           
● Local administrator rights

● The Internet Information Server is installed.

Procedure
1. Insert the WinCC DVD in the drive.

The DVD starts automatically if Autorun is enabled in the operating system. If the autorun 
function is not activated, start the program Setup.exe on the DVD.

2. In the "Installation Type" dialog, select "Package Installation".

3. Select the "WebNavigator Server" installation.

4. Before the installation, the security settings that are adapted for WinCC are displayed in 
the "System Settings" dialog. The firewall is configured automatically. Confirm the changes 
to the system settings.

5. Start the installation.
You can track the status of the installation in the displayed dialog. Select "Cancel" to cancel 
the installation.
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6. You can transfer the license key for the product after installation of the WebNavigator 
server. To do so, click on "Transfer License Key." Select "Next" if you have already 
transferred the license key or want to install it at a later time.

 

  Note

License keys will not be transferred automatically. You will have to transfer missing license 
keys during or after installation with "Automation License Manager" .

 

7. Restart the computer when prompted to do so by setup.

Result
The WebNavigator server is installed and is displayed in the navigation window of the WinCC 
Explorer.

Upgrading the WebNavigator server
If an older WebNavigator server is already installed, this will be recognized by the setup and 
installation will not be possible.

A WebNavigator server can only be upgraded to a newer version if the WinCC basic system 
is upgraded. 

1. Remove the older version of the WebNavigator server using "Change or remove software/
programs" in the control panel.

2. Install the new version of the WinCC basic system as an upgrade without previous manual 
removal.

3. Install the new version of the WebNavigator server.

WinCC/WebNavigator Installation Notes
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1.4 Installing the WebNavigator client

1.4.1 Installing the WebNavigator client

Introduction               
You can install the WebNavigator client as follows: 

● Installation from the WinCC product DVD.
In this case, certain Windows user rights are necessary, depending on the operating system.

● Installation via the Intranet/Internet.
In this case, certain Windows user rights are necessary, depending on the operating system.

● Installation without user interaction:

– Using the Windows user rights of the current user

– Or in networks, using group policy-based software distribution

In addition, you can also install the WebNavigator client on the WebNavigator server. This is 
useful, for example, if you want to check the WinCC project locally on the server in Internet 
Explorer.

 

 Note
.Net controls on the WebNavigator client 

If you wish to use .Net controls on the WebNavigator client, you need to install the .Net 
Framework 4.0 on the client.

 

WinCCViewerRT
The web viewer "WinCCViewerRT" is installed upon installation of the WebNavigator client.

WinCC/WebNavigator Installation Notes
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Procedure
1. Entry and check of the settings of the client computer in Internet Explorer.

2. Installation of the WebNavigator client.
 

  Note

If you are installing from the DVD or using software distribution based on group policy, 
you can directly upgrade an older version of the WebNavigator client without having to 
remove the older client first.
If you install the WebNavigator server on a PC after the WebNavigator client, you will have 
to install the client again.
Plug-in reinstallation

The plug-ins "User Archive Control", "FunctionTrend Control", "Hardcopy" and "Web 
Client" are already integrated in the WebNavigator client as of version V7.0 upon 
installation.

If a WebNavigator client as of V7.0 is connected to a WebNavigator server older than V7.0 
(e.g. V6.2 SP3), you will be offered these plug-ins for installation in the download area of 
the Web navigation user interface.

The plug-ins are already installed. Do not reinstall these plug-ins.
 

Information on the setup and installation of the WebNavigator client:
● Before downloading and installing a new version on the WebNavigator client, check the 

languages installed on the client and connected server. Only the languages of the 
connected server will be available on the client computer following client installation by 
download.

● WebNavigator client setup will be interrupted with the error message "WinCC Active" if the 
local WinCC project is open or has been opened since the PC was last restarted. Restart 
the computer. Check whether WinCC has been included in the Autostart directory. Remove 
the entry if necessary and then restart the computer to execute WebNavigator client 
installation.

● You will need at least 70 MB of free memory space on the local hard disk to install the 
WebNavigator client. Otherwise, the MSI setup will cancel installation with a corresponding 
error message.

● When installing the WebNavigator client by downloading it from the Intranet/Internet, you 
can select to either "Open" or "Save" the setup file. The procedure you select upon initial 
installation of the WebNavigator client must also be selected for the subsequent installation 
of plug-ins or ActiveX controls. Otherwise, the "MSI Installer" service will output the error 
message "Error 1316".
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● In Windows XP, installation of the WebNavigator client can be accelerated if you deactivate 
the setting "Automatically search for network folders and printers" before you commence 
installation. Open the "Folder options" dialog using the menu item "Tools > Folder options" 
in Windows Explorer. Deactivate this option in the "View" tab under "Files and Folders". 
Click on the "Apply to all" button.

● In the download area of the Web Navigation user interface, the Plug-Ins which can be 
installed are displayed. The same minimum user rights are required for installing these plug-
ins as for installation of the WebNavigator client. If you select a plug-in in the Web 
Navigation user interface, WebNavigator client setup will start. You will have to confirm the 
selected plug-in again.

Upgrading the WebNavigator client from a previous version
The current version of the WebNavigator client can be downloaded and installed from the 
website "www.wincc.de" on the "WinCC/WebNavigator and WinCC/DataMonitor demo 
access" page using the "WebNavigator" link.

Upgrade from WinCC V6.2 SP3
Perform a repair installation after upgrading from WinCC V6.2 SP3. To do so start the WinCC/
WebNavigator client installation with "Settings > Control Panel > Software" and select "Repair". 
Otherwise, controls may be reinstalled during operation. Restart the computer.

Installing the WebNavigator client under Windows Server
Installation of the WebNavigator client under Windows Server with a lower user authorization 
than "Administrator" is not possible in the default setting of group policies. 
Enable the installation of the WebNavigator client in the group policy by

● Assigning and making the software public

● Or activating the setting "Always install with elevated privileges" under "Administrative 
Templates / Windows Components / Windows Installer". You must activate "Never" for the 
"Deactivate Windows Installer" option.

1.4.2 User rights, user groups and optional installation possibilities

Windows user rights required for installation and initial registration of the WebNavigator client
"Administrator" rights are required for installing the WebNavigator client via Intranet/Internet 
or using the product DVD. The initial registration of the client on the WebNavigator server must 
take place with the user identification used during installation and the same or higher Windows 
user rights. The connections must be established successfully. All subsequent logins can then 
be performed by users with different Windows user rights, which may be more restricted. 
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Installing the WebNavigator client with limited Windows user rights
The MSI technology used allows you to install the WebNavigator client even with limited 
Windows user rights. This procedure can be set during the installation using the group policy 
based software distribution in networks.

Even the add-ins and plug-ins for the WebNavigator client can be installed. "Administrator" 
rights are required for the installation of plug-ins that were created with the WinCC Plug-In 
Builder.

Installation for a configured group of users or computers
Using the Microsoft Systems Management server or group policy on a Domain Controller, it is 
possible to install a group of users or computers configured by the Administrator.

● For this the MSI file "WinCCWebNavigatorClient.msi" is published at the Domain Controller 
and enabled for a user group. Installation is then performed either during login of the defined 
users or when the computer is started, depending on the configuration of the group policy-
based software distribution.

● When using a Microsoft Systems Management Server, the installation is configured by the 
administrator, triggered and executed when the relevant computer boots.

Group policy-based software distribution
Software is normally installed with the access rights of the current Windows user. When using 
MSI technology, the installation is performed by an operating system service with a higher 
level of rights. This enables installations for which the Windows user does not have the 
necessary rights. Applications which require higher rights for installation are referred to as 
"privileged installations" in MSI technology. Installation of these applications is possible when 
a Windows user is assigned the "Always install with elevated privileges" permission. 

A group policy is created in the domain controller for use of group policy-based software 
distribution. The software to be distributed is then assigned or made public using Active 
Directory. 

● Assignment: Software distribution can be assigned to a user or a computer. The software 
to be distributed is automatically installed when the user logs in or the computer is started.

● Publication: The software distribution can be published for individual users. When the user 
logs on to the client computer, the software to be distributed appears in a dialog and can 
be selected for installation.

Installation without user interaction
During installation of the WebNavigator client, the user is normally prompted to enter 
information, for example on the components to be installed. By implementing a configuration 
file, installation is possible without user interaction. The required path specification and user 
information are provided in the "options.ini" configuration file. The file must be in the same 
directory as the WebNavigator client setup. 
This installation procedure is useful if group policy-based software distribution is being used. 

Installation from the product DVD requires user interaction. 

The settings predefined in the table are used under the following conditions: 
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● The "options.ini" configuration file is missing and there is no corresponding entry available 
in the client registry, for example due to another installed SIMATIC HMI product.

● The installation is performed via group policy-based software distribution with assignment 
to the computer.

Information Parameters
Target directory for WebNavigator client INSTALLDIR=" <syspath1>\Siemens\WinCC"
Target directory for common components COMMONDIR=" <syspath2>\Siemens "
User information / user name USER
User information / organization COMPANYNAME

The "<syspath?>" parameters result from the settings in the registry under the key 
"HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion" :

●  "<syspath1>" corresponds to the key "ProgramFilesDir" e.g. "C:\\Program Files"

●  "<syspath2>" corresponds to the key "CommonFilesDir", e.g. "C:\\Program Files\\Common 
Files"

Example of a "options.ini" configuration file
The configuration file specifies the user information and the target directories. In this example, 
only the standard language "English" is installed. If you want to install an additional language, 
assign the value "1" to the parameter, for example "DEU=1".

[USERINFO]
USER=Integration 
COMPANYNAME=Siemens AG
 
[INSTALLPATH]
COMMONDIR=" C:\Program Files\Common Files\Siemens " 
INSTALLDIR=" C:\Program Files\Siemens\WinCC "
 
[FEATURES]
DEU=0
FRA=0
ITA=0
ESP=0
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1.4.3 Internet Explorer Settings

Introduction       
You have to adapt the Internet Explorer security settings in order to utilize full functionality of 
the WebNavigator Client. 

Procedure
1. Click "Tools > Internet Options" in Internet Explorer.

2. Select the "Security" tab.
Select the corresponding zone, for example, "Local Intranet" or "Internet".

3. Click "Custom Level...".

4. Enable the "Script ActiveX controls marked safe for scripting" and "Download signed 
ActiveX controls" options.

5. Enable "Active Scripting" under "Scripting".

6. Click "OK". Carry out the modifications in the subsequent dialog.

7. Click the "Trusted Sites" icon.
Click the "Sites..." button to open the "Trusted sites" dialog.

8. Enter the address of the WebNavigator Server in the "Add this website to the zone" field. 
Possible formats and wildcards include "*://157.54.100 - 200", "ftp://157.54.23.41", or "http://
*.microsoft.com".
Deactivate the "Require server verification (https:) for all sites in this zone" option. 
Click "Add". Click "OK".

9. Click the "Trusted Sites" icon.
Click the "Standard level" button and then the "Custom Level" button. 
Enable "Initialize and script ActiveX controls not marked as safe". Click "OK".

10.Click on the "General" tab.
Click in the "Settings" area on the "Temporary Internet Files" button.
Enable the "Automatic" option under "Check for newer versions of stored pages:". 
Click "OK".

11.Close the "Internet Options" dialog by clicking "OK".

1.4.4 Installation from the DVD

Requirements     
● For the installation and use of the WebNavigator client, the information in Internet Explorer 

Settings (Page 23) applies.

● Depending on the operating system, specific minimum user rights are required to install 
the WebNavigator client; see User rights, user groups and optional installation 
possibilities (Page 20).
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Procedure
1. Insert the WinCC DVD in the drive.

The DVD starts automatically if Autorun is enabled in the operating system. If the Autorun 
function is not activated, start the program Setup.exe on the DVD.

2. In the "Installation Type" dialog, select "Package Installation".

3. Select the "WebNavigator Client" program package.

4. Before the installation, the security settings that are adapted for WinCC are displayed in 
the "System Settings" dialog. The firewall is configured automatically. Confirm the changes 
to the system settings.

5. Start the installation. You can track the status of the installation in the displayed dialog. 
Select "Cancel" to cancel the installation.

6. Restart the computer when prompted to do so by setup.

Result
The WebNavigator client is now installed and has been added as a function to the navigation 
window of the WinCC Explorer.

1.4.5 Installation via the Intranet/Internet

Requirements    
● For the installation and use of the WebNavigator client, the information in Internet Explorer 

Settings (Page 23) applies.

● Depending on the operating system, specific minimum user rights are required to install 
the WebNavigator client; see User rights, user groups and optional installation 
possibilities (Page 20).

● The WebNavigator server must be installed on a computer. The Internet Information Server 
must be configured with the WinCC Web Configurator. The users must be registered in the 
WinCC User Administrator. The WinCC project must be in runtime.

Procedure
1. Go to the address bar of Internet Explorer and enter the URL "http://www.servername" of 

the WebNavigator server. For installation in a virtual directory, the URL can be as follows: 
"http:// www.servername/WebNavigator/".

2. Type in the user name and password.
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3. The first time you access the WebNavigator server, you will be prompted to install the 
WebNavigator client. Click the "Click here to install" link. Click the "Save" button in the "File 
Download" dialog to store the client setup on the target computer. It is recommended to 
save the Setup file because, in the event of a restart of the client computer being necessary, 
the Setup need not be downloaded again.

 

  Note

If you have already installed the WebNavigator client and wish to install a more recent 
version via the Intranet/Internet, open the client setup straight away. You do not need to 
save the installation file on the target computer. Remove the old installation file first if you 
wish to save the new one. Alternatively, you can save the new version of the file in a 
different directory.

 

4. Leave the Internet Explorer open and open Windows Explorer. Navigate to the directory in 
which you saved the setup file. Start setup by double-clicking on the file.

5. Follow the instructions on the screen and enter the information and settings necessary. 
The client-side controls of the WebNavigator will be installed. Close the Setup dialog.

Result
Following successful installation, the WebNavigator client connects to the WinCC project 
currently in runtime. 
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1.5 Installing the WebNavigator diagnostics client

Introduction     
The software for the WebNavigator diagnostics client is installed on the client computer from 
the DVD.

Requirements
● To do this, you must have administrator rights.

Procedure
1. Insert the WinCC DVD in the drive.

The DVD starts automatically if Autorun is enabled in the operating system. If the Autorun 
function is not activated, start the program Setup.exe on the DVD.

2. In the "Installation Type" dialog, select "Custom Installation".

3. Select the "Diagnose Client" program in the Web Navigator" program group.

4. Before the installation, the security settings that are adapted for WinCC are displayed in 
the "System Settings" dialog. The firewall is configured automatically. Confirm the changes 
to the system settings.

5. Start the installation. You can track the status of the installation in the displayed dialog. 
Select "Cancel" to cancel the installation.

6. Restart the computer when prompted to do so by setup.

Result
The WebNavigator diagnostics client is now installed.
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1.6 WebNavigator Demo Project

Introduction   
The WinCC Demo Project can be downloaded as a self-extracting ZIP file from:

● http://support.automation.siemens.com/WW/view/en/35102867 (http://
support.automation.siemens.com/WW/view/en/35102867)

Installation
To install the project, copy the file in a local target directory and start the decompressing 
process by double-clicking the file.

The following logins are already configured in the demo project:

WinCC Login Password
WebNavigator German winccd winccpass
WebNavigator English wincce winccpass
WebNavigator French winccf winccpass
WebNavigator Italian wincci winccpass
WebNavigator Spanish winccs winccpass
Terminal PocketPC PocketPC winccpass
Terminal Mobic Mobic winccpass
Terminal MP370 MP370 winccpass

See also
http://support.automation.siemens.com/WW/view/en/35102867 (http://
support.automation.siemens.com/WW/view/en/35102867)
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1.7 Deinstallation

Introduction
You can remove the WebNavigator server and WebNavigator client in the usual way, as in 
Windows. 

Procedure
1. Open the Windows "Control panel" under the start menu.

2. Double-click on the "Software" icon.

3. Click the "Change or Remove Programs" icon.

4. Select the WebNavigator server or client and click "Remove". Follow the instructions on 
the screen.

Result
The WebNavigator Server or WebNavigator client has now been removed from the computer.

 

 Note

If you uninstall the WebNavigator server, you should also uninstall the corresponding licenses 
with the "Automation License Manager" program. The licenses can be reactivated later. 
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WinCC/WebNavigator Release Notes 2
2.1 Information about WebNavigator

Introduction
These release notes contain important information.

The statements in these release notes take precedence over information provided in the 
manuals and in the online help.

Please read these release notes carefully as they contain useful information.

Communication via proxy server
Please note the following for communication using a proxy server:

● The WebNavigator client must be a member of the server domain.

● If the users registered on the WebNavigator client have no access to the proxy server, logon 
to the proxy server with NTLM authentication is as follows:
1. The logon dialog for the proxy server appears.
2. The logon dialog for the WinCC user appears.
3. The logon dialog for the proxy server appears again.

Security restrictions with the WebNavigator client.
 

 NOTICE

Security restrictions and response times in Internet Explorer

Please note the Internet-specific security restrictions when using the WebNavigator client. 
The WebNavigator client may take significantly longer (>20 seconds) than a regular WinCC 
client to recognize that the WebNavigator server is down or that the communication is faulty.

 

WebNavigator server: Configure a port other than the standard port "80"
When configuring the port in the WinCC Web Configurator, use "8080", for example, rather 
than the standard port "80".

WebNavigator client: Do not use WinCC project names with national special characters
You cannot use national special characters in the project name for WinCC projects that you 
want to show with the WebNavigator client.
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WebNavigator client: Display of ActiveX controls in Internet Explorer       
ActiveX controls are disabled in Internet Explorer by default. For this reason, the WinCC 
controls are not displayed correctly in Internet Explorer on a WebNavigator client.

To display the WinCC controls correctly, add the Web server as a trusted website and enable 
the ActiveX controls only for the "Trusted sites" zone.

To continue protecting Internet Explorer from foreign ActiveX controls, check that the restricted 
security settings still apply to the other zones after making the changes.

For more information, refer to the following documentation: 

● WinCC/WebNavigator: "WinCC/WebNavigator Installation Notes > Installation of 
WebNavigator Client > Settings in Internet Explorer"

WebNavigator client: Updating pictures with faceplates
To enable updating of changes to pictures with faceplates, you must enable the setting "Every 
time I visit the webpage" in the settings for temporary Internet files in Internet Explorer.

WebNavigator client: Language-dependent texts as text references as of WinCC V7.2
Language-dependent texts via text references are now displayed on the WebNavigator client 
in the language that is currently set on the WebNavigator client. Previously, the texts were 
shown in the language of the associated WinCC server.

WebNavigator client: Manual logoff with ODK function as of WinCC V7.2
Users can now also be logged off manually from the WebNavigator client with the ODK function 
"PWRTLogout()". You will find a description of this function in the ODK documentation under 
"ODK UserAdministrator/Functions for logging in/out".

Secure connection over HTTPS: Memory leak when Windows XP SP3 is used
Access to a WebNavigator server via HTTPS may result in a memory leak when the Windows 
XP SP3 operating system is used. Further information can be found on the Microsoft support 
page:

● http://support.microsoft.com/hotfix/KBHotfix.aspx?kbnum=959658 (http://
support.microsoft.com/hotfix/KBHotfix.aspx?kbnum=959658)

This behavior can be rectified by the following Microsoft patch:

● http://support.microsoft.com/kb/959658 (http://support.microsoft.com/kb/959658)

WinCC uninstallation: WebNavigator client must be installed later.
If you uninstall WinCC, you will need to post-install the WebNavigator client.
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Alarm after installation of a plug-in
The Program Compatibility Wizard may possibly output an alarm during installation of a plug-
in. The plug-in is installed correctly. You may therefore acknowledge this alarm with "The 
program was installed correctly."

Project Change
Following a change of projects, a sporadic inoperable period of the Internet Information 
Services (IIS) may occur. The computer must then be restarted.

WebNavigator server: Using the Trend Micro virus scanner in Windows 7 / Windows Server 2008 SP2
Operation of the Trend Micro "Office Scan" Corporate Edition V10.5 virus scanner in 
Windows 7 or Windows Server 2008 SP2 may have a negative impact on the performance of 
your WebNavigator Server.

Custom ActiveX Controls (Industrial X)
Compatibility with WinCC and WebNavigator server or WebNavigator client must be ensured 
if custom ActiveX Controls (Industrial X) are used:

● Direct installation of ActiveX Controls on the computer with WinCC and WebNavigator 
server or client. You must install the ActiveX control before installing WinCC and the 
WebNavigator server or client. If the ActiveX control does not function without errors after 
this step, there is no compatibility.  

● Installation as a plug-in via the Web Navigation user interface on the WebNavigator client. 
If the ActiveX Control is packaged in a plug-in and installed via download, an upgrade of 
WinCC and the WebNavigator server or client will also require the generation of a new plug-
in using this ActiveX control. Ensure compatible binaries (DLL, OCX, etc.) are used when 
creating the plug-in.

WebNavigator client: "Protected Mode" with Windows 7
"Protected Mode" is not supported for the WebNavigator client under Windows 7.

WebNavigator client: Connection with the WebNavigator server with Windows Server 2008
In order to connect a WebNavigator client to a WebNavigator server as a "user", you must add 
the WebNavigator server as a trusted site.

Security settings in Internet Explorer: Installation via SSL connection
If you want to download the WebNavigator from an ASP portal via an SSL connection, note 
that the download is not possible under certain conditions. You can correct this with one of the 
following settings:
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● Deactivate the "Do not save encrypted pages to disk" option in the "Advanced" tab for the 
Internet options of the Internet Explorer.

● Deactivate the "Internet Explorer Enhanced Security Configuration" option in the "Control 
Panel/Add/Remove Programs/Windows Components".

WebNavigator client: WinCC Alarm Control on a WebNavigator server in WinCC ServiceMode

Initial Situation
The WebNavigator client is connected with a WebNavigator server operated in WinCC 
ServiceMode.

Behavior
If you are using WinCC Alarm Control prior to WinCC V7 that is connected via a server prefix, 
you will not be able to open the selection dialog.

Solution
Use the WinCC AlarmControl that is offered as of WinCC V7.

WebNavigator client: Diagnostics file "WebNavReconnnect.log"
After installation of the WebNavigator client, the diagnostics file "WebNavReconnnect.log" will 
be saved in the "<User>\Application Data\Siemens\SIMATIC.WinCC\WebNavigator\Client" 
directory. The diagnostics file will be saved into the respective user profile so that this user no 
longer requires administrator rights. Under Windows 7 the directory will be available under 
"LocalLow". 

WebNavigator client: WinCC Computer with "Basic Process Control"
The plug-in "WinCC Basic Process Control" must be installed on the WebNavigator client if 
the client is connected to a computer with WinCC Basic Process Control. Without the plug-in, 
the functionality of WinCC Basic Process Control will not be available on the WebNavigator 
client: for example, the relevant ActiveX Controls and the group display will not be available.

The plug-in is on the WebNavigator server in the "<wincc_installationpath>\WebNavigator
\Server\Web\Install\Custom" directory. You can download the plug-in via the WebNavigator 
navigation user interface from the download area.

A description of supported and non-supported functions may be found in WinCC Information 
System under "Options for Process Control > System Overview Process Control Options > 
Configuration in PCS 7 Environment > Web Client". 

If the WebNavigator client is to be installed on a dedicated web server with WinCC Basic 
Process Control, the plug-in "WinCC Basic Process Control" must be installed immediately 
after installation of the WebNavigator client. The download page for the plug-in is displayed. 
You will only be able to exit this page after installation of the plug-in for displaying the process 
pictures.

For more information on the supported functionalities of the WebNavigator client when 
connected to a PCS7 OS, please refer to the PCS7 documentation.  
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WebNavigator client: Downloading plug-ins with Internet Explorer 8
Deactivate the SmartScreen filter in Internet Explorer 8 during the download. Otherwise, the 
plug-in will start twice on completion of the download.

WebNavigator client: "FLAG_COMMENT_DIALOG" of the "GCreateMyOperationMsg" function
The WebNavigator client does not support the parameter "FLAG_COMMENT_DIALOG" for 
the "GCreateMyOperationMsg" function.

See also
http://support.microsoft.com/hotfix/KBHotfix.aspx?kbnum=959658 (http://
support.microsoft.com/hotfix/KBHotfix.aspx?kbnum=959658)

http://support.microsoft.com/kb/959658 (http://support.microsoft.com/kb/959658)
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2.2 Service and Support

2.2.1 Warnings

Safety notes
This manual contains information that must be observed to ensure your personal safety and 
to prevent property damage. Notices referring to your personal safety are highlighted in the 
manual by a safety alert symbol; notices referring to property damage only have no safety alert 
symbol. Depending on the hazard level, warnings are displayed in a descending order as 
follows:

 

 DANGER

means that there can be severe physical injury or even death if the corresponding safety 
measures are not followed.

 

 WARNING

means that there can be severe physical injury or even death if the corresponding safety 
measures are not followed.

 

 CAUTION

means that there can be slight physical injury if the corresponding safety measures are not 
followed.

 

 NOTICE

means that there can be damage to property if the corresponding safety measures are not 
followed.

 

 Note

means an undesirable result or state can occur if the corresponding instruction is not followed.
 

 Note

is an important information about the product, the way to handle the product or the respective 
part of the documentation and we wish to especially bring this to your notice.

 

If multiple levels of hazards can occur, the warning is always displayed with the highest possible 
level. If a warning with a warning triangle is to be indicate physical injury, the same warning 
may also contain information about damage to property.
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Qualified Personnel
The corresponding machine/ system may only be set up and operated with the help of this 
documentation. A device/system must only be commissioned and operated by qualified 
personnel. Qualified persons in the sense of safety instructions in this documentation stand 
for persons who are authorized to operate, earth and mark machines, system and electrical 
circuits according to safety standards.

Proper use
Please observe the following:

 

 WARNING

The machine may only be used for the application instances that have been described in the 
technical description and only in combination with third-party devices and components 
recommended and/or approved by Siemens. Smooth and safe operations demand proper 
transport, proper storage, installation and assembling as well as careful operations and 
maintenance.

 

Brands
All designations with the trademark symbol ® are registered trademarks of Siemens AG. Other 
designations in this documentation may be trademarks whose use by third parties for their own 
purposes can violate the rights of the owner.

Security information
Siemens offers IT security mechanisms for its automation and drive product portfolio in order 
to support the safe operation of the plant/machine. Our products are also continuously 
developed further with regard to IT security. We therefore recommend that you keep yourself 
informed about updates and upgrades for our products and always use the latest version of 
each product. You can find information on this at:

● http://support.automation.siemens.com (http://support.automation.siemens.com) 

You can register for a product-specific newsletter here.

For the safe operation of a plant/machine, however, it is also necessary to integrate the 
automation components into an overall IT security concept for the entire plant/machine, which 
corresponds to the state-of-the-art IT technology. You can find information on this at:

● http://www.siemens.com/industrialsecurity (http://www.siemens.com/industrialsecurity) 

Products used from other manufacturers should also be taken into account here.

Disclaimer of liability
We have checked the contents of the description to ensure that it matches with the hardware 
and the software it describes. Nevertheless, we cannot assume responsibility for any 
deviations that may arise. The details outlined in this description are checked regularly and 
the required corrections are done in the subsequent editions. Suggestions for improvement 
are welcomed.

WinCC/WebNavigator Release Notes
2.2 Service and Support

WinCC/WebNavigator
System Manual, 07/2013, A5E32316269-AB 35

http://support.automation.siemens.com
http://www.siemens.com/industrialsecurity


The statements in the online documentation are more binding than the statements in the 
manuals and PDF files.

Please follow the Release Notes and Installation Notes. The information in these Release 
Notes and Installation Notes has priority over that in the manuals and online help with regard 
to legal validity.

Copyright © Siemens AG 2012
Änderungen vorbehalten / All rights reserved

It is prohibited to transfer, copy, evaluate or communicate this document in full or part unless 
the same has been explicitly approved. Violation of this rule can lead to claims for damage 
compensation. All rights reserved, especially for granting patents or for GM registration.

Siemens AG

Automation and Drives

SIMATIC Human Machine Interfaces

P.O. Box 4848

D-90327 Nuremberg, Germany

 

See also
http://support.automation.siemens.com (http://support.automation.siemens.com)

http://www.siemens.com/industrialsecurity (http://www.siemens.com/industrialsecurity)

2.2.2 Customer Support

Customer Support and Technical Support      
You can reach the SIMATIC hotlines at the times specified in the following table. The SIMATIC 
hotline employees speak German and English. The Authorization hotline offers French, Italian 
or Spanish customer support in addition to German and English.

Technical support

Nuremberg (GMT +1:00)
Service HoursMonday - Friday, 8:00 to 17:00 (CET/CEST)
Phone +49 (0)911 895 7222
Fax +49 (0)911 895 7223
E-mail http://www.siemens.com/automation/support-request  (http://

www.siemens.com/automation/support-request)

An overview of the Technical Support is available at the following URL:
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● http://support.automation.siemens.com/WW/view/en/16605032 (http://
support.automation.siemens.com/WW/view/en/16605032)

Automation Value Card (AVC)
The Automation Value Card (AVC) provides extended Technical Support and is available 24 
hours every day of the week. Information on the AVC can be found at the following URL:

● http://support.automation.siemens.com/WW/view/en/21981898 (http://
support.automation.siemens.com/WW/view/en/21981898)

SIMATIC Customer Online Support 

Service and Support 
An overview of the support offering for our products is available at the following URL:

● http://www.siemens.com/automation/service&support (http://www.siemens.com/
automation/service&support)

In Product Support, for example, you will find downloads of firmware updates, service packs 
and useful utilities.

Online Help is available so that you can successfully use the Support offering. Open the Online 
Help by selecting the corresponding button on the Internet site or at the following URL:

● http://support.automation.siemens.com/WW/support/html_00/help/Online_Hilfe.htm (http://
support.automation.siemens.com/WW/support/html_76/help/Online_Hilfe.htm)

WinCC FAQs
WinCC Online Support with information on FAQs (Frequently Asked Questions) may also be 
found at the following URL:

● http://support.automation.siemens.com/WW/view/de/10805548/133000 (http://
support.automation.siemens.com/WW/view/en/10805583/133000)

Searching in the Support database
The topic-related search in the Support database can be found under the following URL:

● http://www.siemens.com/automation/csi/km (http://www.siemens.de/automation/csi_en/
km)

Technical Forum
The Technical Forum supports exchange with other SIMATIC users. It is available at the 
following URL:

● http://www.siemens.com/automation/csi/forum (http://www.siemens.de/automation/csi_en/
forum)

Technical documentation for SIMATIC products
You can find a guide to the technical documentation provided for individual SIMATIC products 
and systems at the following URL:
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● http://www.siemens.com/simatic-tech-doku-portal (http://www.siemens.com/simatic-tech-
doku-portal)

Contact person database
To contact your local agent, search our contact database at the following URL:

● http://www.automation.siemens.com/partner/index.asp (http://
www.automation.siemens.com/partner/index.asp?lang=en)

Product Information 

SIMATIC WinCC
Go to the following URL for additional information about WinCC products:

● http://www.siemens.com/wincc (http://www.siemens.com/wincc)

SIMATIC Products
Go to the following URL for additional information about SIMATIC products:

● http://www.siemens.com/simatic (http://www.siemens.com/simatic)

See also
Internet: Support Request (http://www.siemens.com/automation/support-request)

Internet: Technical support (http://support.automation.siemens.com/WW/view/en/16605032)

Internet: Automation Validation Card (AVC) (http://support.automation.siemens.com/WW/
view/en/21981898)

Internet: Service and Support (http://www.siemens.com/automation/service&support)

Internet: WinCC FAQs (http://support.automation.siemens.com/WW/view/en/
10805583/133000)

Internet: Support Technical Forum (http://www.siemens.de/automation/csi_en/forum)

Internet: Support Search (http://www.siemens.de/automation/csi_en/km)

Internet: Support Online Help (http://support.automation.siemens.com/WW/support/html_76/
help/Online_Hilfe.htm)

Internet: Technical documentation for SIMATIC products (http://www.siemens.com/simatic-
tech-doku-portal)

Internet: Contact person database (http://www.automation.siemens.com/partner/index.asp?
lang=en)

Internet: Information about WinCC (http://www.siemens.com/wincc)

Internet: SIMATIC Products (http://www.siemens.com/simatic)

2.2.3 Support Request
Dear customer
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In order to provide you with fast and effective support, please complete the "Support Request" 
form online on the Internet. Describe the problem in as much detail as possible. We would 
appreciate if you would provide us with all project data, so that we can reproduce the error 
situation or shorten the turn-around time.

Before filling out the support request, check whether your configured quantity structure is within 
the range of tested quantity structures (see topic "Performance Data").

Support Request form
The Support Request form is available at the following URL:   

● http://www.siemens.com/automation/support-request (http://www.siemens.com/
automation/support-request)

When filling out the report, you will be guided through several steps, which will ask about all 
required information.

A detailed description of the Support Request can be found at the following URL:

● http://support.automation.siemens.com/WW/view/en/16605654 (http://
support.automation.siemens.com/WW/view/en/16605654)

Procedure
1. Open the "Support Request" form using the link on the Internet. Step 1 "Select product" is 

displayed:

2. Enter the project name in the "Product/Order number" box. Upper/lower case is not relevant.
Search for parts of the product name or enter the full product name in the correct order. 
You can e. g. search for the following terms:
- "WinCC Runtime"
- "WinCC DataMonitor"
- "wincc webnavigator"
- "Connectivity"
The found products are offered in the "Product selection" field. 

3. Select the desired product and click on "Next" to switch to step 2 "Select use case".

4. Select a use case or describe your specific use case in the "Other use case" field.

5. Press "Next" to switch to step 3 "Our solutions".
Suggested solutions and FAQs for the selected key words are listed.
Once you have found a suggested solution for your problem, you can close the form in the 
browser.
If you did not find any applicable suggested solutions, press "Next" to switch to step 4 
"Describe problem".
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6. Describe your problem as exactly as possible in the "Details" field.
Pay particular attention to the following questions and comments. Please also check the 
WinCC installation and configuration with regard to the following references.
If you have any idea what has caused the error, please let us know. No detail should be 
omitted, even if you consider it unimportant.
- Was the configuration data created with older WinCC versions?
- How can the error be reproduced?
- Are other programs running simultaneously with WinCC?
- Have you deactivated the screen saver, virus checker and power management function?
- Search the computer for log files (WinCC\Diagnose\*.log, drwatson.log, drwtsn32.log). 
The log files are needed for error analysis. Thus, be sure to send the log files as well.

7. Use the "Search" button to upload your affected project and the log files (e. g. as a Zip file) 
to the Support Request.
Press "Next" to switch to step 5 "Provide contact information".

8. Enter your contact information.
Read the privacy notice and choose whether your personal data should be permanently 
saved.
Press "Next" to switch to step 6 "Summary & Send".

9. Press the "Print" button if you would like to print the support request.
You close the support request by clicking the "Send" button.
Your data will be transmitted to Customer Support and processed there.

 

Thank you for your cooperation. We hope that we can be of assistance in solving your problems.

Your WinCC Team 

See also
Internet: Error Report (http://www.siemens.com/automation/support-request)

Internet: Overview of Support Request  (http://support.automation.siemens.com/WW/view/en/
16605654)
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WinCC/WebNavigator Getting Started 3
3.1 First Web Project

Introduction 
WinCC/WebNavigator provides a solution for operator control and monitoring of the automation 
system via the Intranet and Internet. WinCC/WebNavigator offers you an easy and efficient 
way of implementing the operator control and monitoring functions of the WinCC project.

The optional "WinCC/WebNavigator" package consists of server components that you install 
on the WebNavigator server. You need the WebNavigator client components on the computer 
that you are using to control and monitor the process pictures that are displayed as in the 
WinCC basic system. For this purpose, use Internet Explorer or the "WinCCViewerRT" Web 
Viewer on the client.

WinCC/WebNavigator also contains the "WebNavigator Diagnostics Client" component. The 
functionality of this Diagnostics Client is no different from that of a WebNavigator client. The 
Diagnostics Client provides cost-effective and reliable access to one or several WebNavigator 
Servers for diagnostics purposes. 

Overview
This Getting Started is based on the WinCC demo project. For this example project, WinCC, 
WebNavigator Server and WebNavigator Client are installed on the same computer. 

Edit the WinCC project on the WebNavigator Server. Use the WebNavigator Client if you 
access the project with Internet Explorer or "WinCCViewerRT". 

Requirement
● The WinCC basic system is installed.

● You have installed the WinCC demo project. Information about its installation is available 
in the chapter "Information about installation of the WinCC demo project (Page 27)".

● WebNavigator Server is installed. Information about its installation is available in the 
"Information about installation of the WebNavigator Server (Page 14)" chapter.
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Procedure
Perform the following steps for the first Web project:

● Configure the WinCC project

– Publish the WinCC process pictures for web access

– Administer the users for WebNavigator Client

● Configuring the WebNavigator Server

– Configure the WebNavigator web page

– Configure the firewall

– Check the activated web page

● Operating the WinCC project

– Configure the Internet Explorer settings

– Install the WebNavigator Client and operate the WinCC project using Internet Explorer

– Set up WinCCViewerRT and operate the WinCC project using WinCCViewerRT 

● Creating a new process picture and displaying it on the WebNavigator client

See also
Creating a new process picture (Page 69)

Installing the WebNavigator Client (Page 62)

Administering the users for WebNavigator Client (Page 49)

Starting the demo project (Page 51)
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3.2 Configuring the WinCC project

3.2.1 Publishing process pictures

Introduction
If you wish to display WinCC process pictures on the WebNavigator Client, you must publish 
them first. For publishing the pictures, use the Web View Publisher, which automatically makes 
the necessary adjustments to the project data. 
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Procedure
1. Select "WebNavigator" in the navigation window of WinCC Explorer.

Select the "Web View Publisher" command from the shortcut menu. The WinCC Web 
Publishing Wizard is now launched.

2. Click "Next".
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3. Select the WinCC project folder under "Path to your WinCC project".
Select the target folder for the published pictures under "Publishing folder of the WinCC 
Web". 
Accept the proposed folder within the WinCC project folder.
Click "Next". 
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4. Move the pictures that you wish to publish to the "Selected files" list.

Click "Next".
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5. Move the necessary C project functions to the "Selected files" list.

Click "Next".
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6. Move the graphics used in the process pictures to the "Selected files" list.

Click "Next".

7. To start publishing the pictures, click "Finish".
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Result
The results list displays the status of all published objects. You can click an object to view 
additional object information. 

You have successfully published the pictures and functions.

3.2.2 Administering the users for WebNavigator Client

Introduction
In order to enable a user to access a WinCC project via a WebNavigator Client, you must 
assign the appropriate authorizations to the user in the WinCC User Administrator. You can 
select a different start picture and runtime language for each user. 
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Procedure
1. Right-click "User Administrator" in the navigation window of the WinCC Explorer. Select 

the "Open" command from the shortcut menu. 

2. You can use an existing user for the Web project. Select the user named "winccd" who has 
been assigned the login "winccd" and password "winccpass", for example, or create a new 
user based on this template.

3. Select the "Add user" command from the "Users" menu if you want to create a new user.

4. Specify the login and password for the new user.

5. Select the new user in the navigation window of the User Administrator.

6. Select the "WebNavigator" check box in the table window. The "Web Options" area is 
displayed.

7. Use the "..." button to select the start picture for this user, e.g. "winccPic.pd_". You can only 
select published pictures as start pictures.  

8. Use the "..." button to select the Runtime language for the user. You can select one of the 
languages installed in WinCC.

9. Select the required user rights by double-clicking in the "Authorization" column of the table 
window. If system authorization no. 1002 "Web access - monitoring only" has been enabled, 
the user is only allowed to monitor the WinCC project when acting as WebNavigator Client.

10.Close the User Administrator.
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3.3 Configuring the WebNavigator Server

3.3.1 Starting the demo project

Introduction
You have copied the WinCC demo project to the computer. In this step, you set up the Web 
project for the computer that acts as both WebNavigator Server and WebNavigator Client.     

Procedure
1. Start WinCC by selecting "SIMATIC > WinCC > WinCC Explorer" in the Windows Start 

menu.

2. Open "DemoProjectV7".

3. Click "Start server locally" in the next dialog. The WinCC project can only be activated if 
your computer has been entered as an available server in the computer list.

4. Right-click "Computer" in the navigation window of WinCC Explorer and select 
"Properties...".

5. Click the "Properties" button in the dialog.

6. Enter the computer name in the "Computer name" field.

7. Click "OK". Restart the project to activate your changes.

8. Close the project by selecting "File > Exit".

9. Reopen the demo project to configure the WebNavigator Server.

See also
Configuring the WebNavigator web page (Page 51)

3.3.2 Configuring the WebNavigator web page

Introduction
The WinCC Web Configurator is used to set up and manage the Microsoft Internet Information 
Service (IIS). You will be creating a default web page in this step.

Requirement
● The WebNavigator Server is installed.

● The Windows "Internet Information Service" component is installed.
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Procedure
1. Select "WebNavigator" in the navigation window of WinCC Explorer.

Click the "Web Configurator" command in the shortcut menu. 
Click "Next" on the start page.

2. Enable the "Create a new standard web page (standalone)" option and then click "Next".
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3. Enter the name "WebNavigator" for the web page.

4. Select the default port "80" in the "Port" field.

5. Select an "IP address". Use only the addresses that are available in the selection list.
Select "All not assigned" to enable Intranet and Internet access to the computer.

6. Select "WebClient.asp" as the default web page.

7. Click "Finish" if you have not activated a Firewall.
Click "Next" if you have installed a Firewall.

Result
You have created the Web folder and activated the web page.     

3.3.3 Configuring the Firewall

3.3.3.1 Configuring the Firewall in Windows XP/Windows 2003

Introduction       
This section describes how to activate the "HTTP" or "HTTPS" services and the procedure for 
other port settings in Windows XP or Windows 2003.
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Requirement
● A default web page was created using the Web Configurator.

● The Firewall is activated.

● The user who is logged has Windows administrator rights.

● You have to set up the HTTPS service in IIS if you are using it for WebNavigator. For more 
information, refer to "Setting up an HTTPS service in IIS (http://support.microsoft.com/kb/
324069)".
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Procedure for the default port
1. Click the "Windows Firewall" button in the Web Configurator.

The "Windows Firewall" dialog opens.

2. Click the "Advanced" tab.
Select the required network connection and then click the "Settings" button.
The "Advanced Settings" dialog opens.
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3. Select the "Secure Web server (HTTPS)" or "Web server (HTTP)" check box.
Click the "Edit" button to display the current service settings for the web server.

4. Close all Windows dialogs with "OK".

5. Click "Finish" in the Web Configurator. The server configuration is completed.
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Procedure for other port settings
Customize the Windows Firewall settings as follows if you are not using the default port.

1. Click the "Windows Firewall" button in the Web Configurator. The "Windows Firewall" dialog 
opens.

2. Click the "Advanced" tab.
Select the required network connection and then click the "Settings" button. The "Advanced 
Settings" dialog opens.

3. Click "Add" in the " Advanced Settings" dialog.
The "Service Settings" dialog opens.
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4. Specify the web server settings:

– Web server name in the "Service description" field

– Name or IP address

– External and internal port number for this service

– "TCP" service

Confirm with "OK".

5. Activate the web server you created in the "Advanced Settings" dialog.

6. Close all Windows dialogs with "OK".

7. Click "Finish" in the Web Configurator. The server configuration is completed.

3.3.3.2 Configuring the Firewall in Windows 7/Windows 2008

Introduction       
The chapter describes how to activate "HTTP" and "HTTPS" services for port "80" in Windows 
7 or Windows 2008.

Consult your network administrator if you want to set up the Windows Firewall with advanced 
security or for a different port.

Requirement
● You have created a default web page with Web Configurator.

● The Firewall is activated.

● The user who is logged has Windows administrator rights.

● You have to set up the HTTPS service in IIS if you are using it for WebNavigator. For more 
information, refer to "Setting up an HTTPS service in IIS (http://support.microsoft.com/kb/
324069)".

Procedure for the default port
1. Click the "Windows Firewall" button in the " WinCC Web Configurator".

The "Windows Firewall" dialog opens.

2. Windows 7: Click "Allow a program or feature through Windows Firewall".
Windows 2008: Click "Allow a program to communicate through Windows Firewall".

3. Activate "Secure WWW services (HTTPS)" or "WWW services (HTTP)".

4. Close all Windows dialogs with "OK".

5. Click "Finish" in the Web Configurator.
The server configuration is completed.
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3.3.4 Check the activated web page

Procedure in Windows XP/2003       
1. Select "Programs > Administration > Internet Information Services" from the Windows Start 

menu. The "Internet Information Services" editor opens.

2. Click on the plus symbol next to the computer name in the "Structure" field.

3. Click on the plus symbol next to "Websites". The data window displays the corresponding 
web pages.

4. Check the view of the web pages.
If the status "Stopped" is displayed next to the required web page, for example, 
"WebNavigator", start the web page. 
Select the "Start" command from the shortcut menu to launch the web page.

5. Close the editor. The web page is activated.
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Procedure in Windows 7/2008
1. Select "All programs > Administration > Internet Information Services (IIS) Manager" from 

the Windows Start menu.

2. Click the computer name in the "Connections" field.

3. Click "Default Web Site".

4. Check the view of the web pages.
If the status "Stopped" is displayed next to the required web page, for example, 
"WebNavigator", start the web page.
Select the "Start" command from the shortcut menu to launch the web page.

5. Close the "Internet Information Services (IIS) Manager". The web page is activated.
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3.4 Operating the WinCC project

3.4.1 Operating the WinCC project with Internet Explorer

3.4.1.1 Internet Explorer Settings

Introduction       
You have to adapt the Internet Explorer security settings in order to utilize full functionality of 
the WebNavigator Client. 

Procedure
1. Click "Tools > Internet Options" in Internet Explorer.

2. Select the "Security" tab.
Select the corresponding zone, for example, "Local Intranet" or "Internet".

3. Click "Custom Level...".

4. Enable the "Script ActiveX controls marked safe for scripting" and "Download signed 
ActiveX controls" options.

5. Enable "Active Scripting" under "Scripting".

6. Click "OK". Carry out the modifications in the subsequent dialog.

7. Click the "Trusted Sites" icon.
Click the "Sites..." button to open the "Trusted sites" dialog.

8. Enter the address of the WebNavigator Server in the "Add this website to the zone" field. 
Possible formats and wildcards include "*://157.54.100 - 200", "ftp://157.54.23.41", or "http://
*.microsoft.com".
Deactivate the "Require server verification (https:) for all sites in this zone" option. 
Click "Add". Click "OK".

9. Click the "Trusted Sites" icon.
Click the "Standard level" button and then the "Custom Level" button. 
Enable "Initialize and script ActiveX controls not marked as safe". Click "OK".

10.Click on the "General" tab.
Click in the "Settings" area on the "Temporary Internet Files" button.
Enable the "Automatic" option under "Check for newer versions of stored pages:". 
Click "OK".

11.Close the "Internet Options" dialog by clicking "OK".
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3.4.1.2 Installing the WebNavigator Client

Introduction
This chapter describes how to install the WebNavigator Client on the WebNavigator Server 
via Intranet/Internet.

Requirement
● The WebNavigator Server is installed.

● The "WinCC WebNavigator" license is installed.

● The WinCC project is in Runtime.

● The WinCC pictures are configured and published for web access.

● A user for the WebNavigator Client has been created in WinCC.

● Internet Explorer

Procedure
1. Go to the address bar of Internet Explorer and enter the URL "http://www.<servername>" 

of the WebNavigator Server.

2. Type in the user name and password, for example, "winccd".
The first time you access the WebNavigator Server, you are prompted to install the 
WebNavigator Client. Click on the link "Click here to install". 

3. Click "Save" in the "File Download" dialog to save the client setup to the target computer. 
Saving the client setup to the client computer saves you from having to download the data 
once again if you have to restart the client computer.

4. Select the destination folder for the setup file of the WebNavigator Client in the next dialog. 
 

5. Without closing Internet Explorer, open Windows Explorer. Navigate to the folder in which 
you saved the Setup file. Start the setup by double-clicking on setup.exe.

6. Follow the instructions on the screen and make the necessary entries and settings.

7. Select the "Complete" option in the "Setup type" dialog to install all components of the 
Client. Click "Next".

8. Click "Install" in the next dialog.

9. Click "Finish" in the "Install Wizard completed" dialog.

Result
On successful installation, the WebNavigator Client connects to the WinCC project currently 
in Runtime. The standard web page is displayed with the picture that you specified for the user 
in the User Administrator.
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During installation of the WebNavigator client, the "WinCCViewerRT" Web viewer is also 
installed. "WinCCViewerRT" is a viewing program that you can use in place of Internet Explorer 
to visualize the WinCC project.

3.4.2 Operating the WinCC project using WinCCViewerRT

3.4.2.1 Configuring WinCCViewerRT

Introduction           
WinCCViewerRT is a program for visualizing WinCC projects. You can configure 
WinCCViewerRT for operation with the WebNavigator Server and Graphics Runtime.

Requirement
● On the server

– The WebNavigator Server is installed.

– A WinCC/WebNavigator license is installed.

– The WinCC project is in Runtime.

– The WinCC pictures are configured and published for web access.

● On the client

– The WebNavigator Client is installed.
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Procedure
1. Double-click the link "WinCCViewerRT.exe" in the "Webnavigator\Client\bin" installation 

folder.
The configuration dialog opens if you reconfigure WinCCViewerRT. 
WinCCViewerRT opens if WinCCViewerRT has already been set up. Use the <Ctrl+Alt+P> 
key combination to open the configuration dialog of WinCCViewerRT.

2. Enter the login data in the "General" tab:

– Server address: http://<server name> or http://<IP address>

– User name and password, if you want to specify a default user for the login dialog.

– The user settings you configured in the User Administrator will be activated if you enable 
the "Apply project settings" option.

3. Specify the Runtime language in the "Parameters" tab.
If necessary, disable any key combinations with which the user switches to other programs. 
If required, you can modify the preset <Ctrl+Alt+P> key combination that is used to open 
the WinCCViewerRT configuration dialog.
Define a key combination with which a user can log off and a new user can log on. The key 
combination can only be used if no default user has been set in the "General" tab.
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4. Specify the WinCC Runtime properties in the "Graphics Runtime" tab:
- Start picture
- Configuration file for user-defined menus and toolbars
- Window attributes
- Impermissible user actions
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5. Specify additional user actions in the "Runtime" tab:
‑ Activating the screen keyboard
‑ <Ctrl+Alt+Del> key combination to allow switching to the Task Manager or operating 
system via the screen keyboard.
- Auto-logoff settings

6. Close the dialog with the "OK" button.

Result
WinCCViewerRT is configured. The connection to the WebNavigator Server is set up after you 
close the dialog. The settings are saved to the "WinCCViewerRT.xml" configuration file. The 
configuration file settings are used at the next start of WinCCViewerRT. WinCCViewerRT 
applies the user interface language from WinCC.

The configuration file is saved in the folder "Documents and Settings\<User>\Application Data
\Siemens\SIMATIC.WinCC\WebNavigator\Client". You can rename the file, for example, to 
"User1.xml". You can also start WinCCViewerRT by means of the command line with the user-
specific configuration file, e.g. "WinCCViewerRT.exe User1.xml". This procedure allows for 
different configurations, depending on the logged-on user. 

The WinCCViewerRT configuration dialog opens at the start if you rename or delete 
"WinCCViewerRT.xml". Reconfigure WinCCViewerRT or select a different configuration file.

 

 Note

WinCCViewerRT can only be closed by means of script function if you disable a key shortcut 
or hide the "Close" button. Function in the C-Script: DeactivateRTProject; function in the 
VBScript: HMIRuntime.Stop.
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3.4.2.2 Operating the WinCC project

Requirement       
● On the server

– The WebNavigator Server is installed.

– The "WinCC WebNavigator" license is installed.

– The WinCC project is in Runtime.

– The WinCC pictures are configured and published for web access.

– The user is created in WinCC.

● On the client

– WinCCViewerRT is configured.

Procedure
1. Start "WinCCViewerRT" in the Windows Start menu with "Programs > Siemens Automation 

> Options and Tools > HMI Tools".

2. Log on to the WebNavigator Server:

– A login dialog is not displayed if the user name and password is preset in the 
"WinCCViewerRT" configuration dialog. You are logged on automatically with the stored 
login data.

– The login dialog is displayed if a user name and password is not set in the 
"WinCCViewerRT" configuration dialog. Enter the user name and password of the 
WinCC user. Click "OK".

3. To change the user, use the specified key combination for "WinCCViewerRT" login/logoff. 
The previous user is logged off. Enter the user name and password of the new WinCC user 
in the login dialog. Click "OK". 
The key combination can only be used if no default user has been set.

Result
WinCCViewerRT automatically connects to the activated WinCC project. The start picture that 
is configured for the user is displayed. 

The user may operate or monitor the project, depending on authorizations. Users assigned 
system authorization No. 1002 "Web access - monitoring only" in the User Administration are 
only allowed to monitor the WinCC project.

The "View Only Cursor" indicates that process-related operations are not possible. 
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Certain operations, such as opening the properties dialog of a WinCC OnlineTrendControl, 
are still possible. 

You can also use your own cursor icon as a "View Only Cursor", if required. For more 
information, refer to "Configuring Runtime settings (Page 95)".

The <F5> key triggers a reselection of WinCCViewerRT.
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3.5 Creating a new process picture and displaying it on the client

3.5.1 Creating a new process picture

Introduction
Configure a new process picture for the web project on the server. Create a trend window that 
displays the measured values from the archive of the WinCC demo project. 

Requirement
●  The WinCC demo project is open. 

Procedure
1. Click "Graphics Designer" in the navigation window of WinCC Explorer. Right-click in the 

data window and select the " New picture" menu command.

2. In the object palette of Graphics Designer, double-click "WinCC OnlineTrendControl" on 
the "Controls" tab. The control is inserted into the picture and the configuration dialog 
opens. 
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3. Click the "Trends" tab. Click  at the tag name in the "Data connection" field. Select the 
"Measured values" archive and "T01" tag in the "Archive/tag selection" dialog.

4. Click "OK". The measured values from "T01" are linked to the trend.

5. If required, configure additional properties of the trend or control.

6. Save the control under the name "NewTrend.pdl" and close Graphics Designer.

Result
You have successfully created a trend window in a picture on the WebNavigator Server. In 
order to display the trend window on the WebNavigator Client, you must publish the picture 
and assign it to a user as start picture. 

See also
Configuring a new process picture for the web (Page 71)
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3.5.2 Configuring a new process picture for the web

Introduction
In order to display the trend window on the WebNavigator Client, you must publish the picture 
and assign it to a user as start picture.

Requirement
● The WinCC demo project is open.

● You have successfully created a trend window in a picture on the WebNavigator Server.

Procedure
1. Right-click "WebNavigator" in the navigation window of the WinCC Explorer. Select the 

"Web View Publisher" command from the shortcut menu.

2. Select the new "NewTrend.pdl" picture in the "Files" field of the "Select pictures" dialog of 
the Publishing Wizard. Move the file to the "Selected files" list.

3. Follow the further instructions of the Publishing Wizard. The picture is published after you 
have completed the Wizard.

4. Right-click "User Administrator" in the navigation window of WinCC Explorer and select the 
"Open" command from the shortcut menu.

5. Select the user with whom you wish to display the new trend window from the navigation 
window of the User Administrator.

6. Select the "WebNavigator" check box in the table window. The "Web Options" area is 
displayed.

7. Click "..." to select the "NewTrend.pd_" start picture.

8. Close the User Administrator.

Result
You have successfully configured the picture that contains the trend window for visualization 
on the WebNavigator Client.     

See also
Displaying the process picture on the WebNavigator Client (Page 72)

Administering the users for WebNavigator Client (Page 49)

Publishing process pictures (Page 43)
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3.5.3 Displaying the process picture on the WebNavigator Client

Introduction   
You want to display the new process picture on the WebNavigator Client Use the 
"WinCCViewerRT" Web Viewer for this example.

Requirements
● The WebNavigator Server and the "WinCC WebNavigator" license are installed.

● The user is created in WinCC.

● A process picture is created in WinCC.

● The process picture is published and assigned to the user as start picture.

● The WinCC project is in Runtime.

● WinCCViewerRT is configured.

Procedure
1. Select the "Start > Programs > Siemens Automation > Option and Tools > HMI Tools > 

WinCCViewerRT" command in the Windows Start menu.

2. Log on to the WebNavigator Server:

– A login dialog is not displayed if the user name and password are set in the 
"WinCCViewerRT" configuration dialog. You are logged on automatically with the stored 
login data.

– The login dialog is displayed if a user name and password is not set in the 
"WinCCViewerRT" configuration dialog.
Enter the user name and password in the "General" tab. Click "OK".

3. You can use the preset <Ctrl+Alt+P> key combination to change the user. The 
"WinCCViewerRT" configuration dialog opens.
Enter the user name and password in the "General" tab. Click "OK".
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Result
The trend window is displayed in the "WinCCViewerRT" Web Viewer. The trend values are 
loaded from the archive.

See also
Configuring WinCCViewerRT (Page 63)

Operating the WinCC project (Page 67)
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WinCC/WebNavigator Documentation 4
4.1 Function overview

Introduction             
WinCC/WebNavigator provides a solution for operator control and monitoring of the automation 
system via the Intranet and Internet. WinCC/WebNavigator offers you an easy and efficient 
way of implementing the operator control and monitoring functions of the WinCC project. 
Current Internet security methods are supported. Use SSL encryption to increase Internet 
security.

The optional "WinCC/WebNavigator" package consists of the following components: 

● WebNavigator Server

● WebNavigator Client

● WebNavigator Diagnostics Client

WebNavigator Server
All necessary WinCC pictures and functions that are displayed on the WebNavigator Client 
are stored on the WebNavigator Server. The Web View Publisher automatically makes the 
required adaptations to the project data that is necessary for the web. This ensures the best 
possible performance.

The WebNavigator Server needs Microsoft Internet Information Service (IIS) for 
communication with the WebNavigator Clients. The IIS is set up and managed using the 
WinCC Web Configurator.

The "Load Balancing" function allows you to automatically distribute the WebNavigator Clients 
evenly to different WebNavigator Servers, in accordance with the respective server license.

WebNavigator Client
The WebNavigator Client is started in Internet Explorer with enabled ActiveX controls. You 
can operate and monitor a current WinCC project without the entire WinCC basic system 
having to be installed on the computer.

You control access of the WebNavigator Clients in the user administration. A different start 
picture and language can be selected for each user. You can enable scalable access to 
different project areas and functions for individual users by assigning user authorizations. 

The "WinCCViewerRT" Web Viewer program is used for visualization of web projects only. 
The program can be used in place of Internet Explorer to visualize the WinCC project.
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WebNavigator Diagnostics Client
The WebNavigator Diagnostics Client is particularly useful for the following activities:

● Remote diagnostics and operator control of multiple unmanned WinCC stations.

● Central remote maintenance using a Diagnostics Client to monitor several WebNavigator 
Servers.

● For Power Users who need guaranteed server access at all times. 

The functionality of this Diagnostics Client is no different from that of a WebNavigator client. 
However, the Diagnostics Client provides guaranteed access to the WebNavigator Servers at 
all times. Access is independent of the number of users already logged on to the WebNavigator 
Server.

The Diagnostics Client licensing provides you with a cost-effective solution for accessing many 
WebNavigator Servers using one or a few WebNavigator Clients. You can combine 
WebNavigator and diagnostics licenses. The WebNavigator Server needs a Diagnostics 
Server license if a WebNavigator license is not already available.
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4.2 Possible applications of WinCC/WebNavigator

4.2.1 WebNavigator Server on the WinCC Server

Linking WebNavigator Clients and WinCC projects via Intranet/LAN         
The WinCC Server and the server component of the Web Navigator are installed on the same 
computer. The WebNavigator Clients operate and/or monitor the current server project via 
Intranet/LAN in an isolated solution.

This cost-effective solution allows you to set up computer stations, for example, for the purpose 
of monitoring or maintenance. It is not necessary to install the complete WinCC system on 
these computers.

Linking the WebNavigator Clients and WinCC projects via Internet and Intranet
The WinCC Server and the server component of the Web Navigator are installed on the same 
computer. The WebNavigator Clients are able to operate and/or monitor the current server 
project via Internet and Intranet.

Two Firewalls are employed to protect against malicious attacks from the Internet. The first 
firewall protects the WebNavigator Server against an attack from the Internet. The second 
Firewall provides additional security for the Intranet.
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4.2.2 Separation of the WinCC and WebNavigator servers

Communication via a channel             
A group of automation systems is assigned to the WinCC Server. The project includes all data 
such as programs, configuration data and miscellaneous settings. On the computer that 
contains the WinCC and WinCC WebNavigator servers, the WinCC project is mirrored 1:1 and 
not networked with the automation systems.

Data is synchronized via the OPC channel. For this purpose, the WinCC WebNavigator Server 
needs a license for the number of OPC tags.

Two firewalls are employed to protect the system against unauthorized access. The first firewall 
protects the WebNavigator Server against an attack from the Internet. The second firewall 
provides additional security for the intranet.
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Communication via the process bus
On the computer that contains the WinCC and WinCC WebNavigator servers, the WinCC 
project is mirrored 1:1. Data is synchronized via the process bus. Two firewalls are employed 
to protect the system against unauthorized access.

4.2.3 Dedicated Web Server

Introduction       
Installation of a dedicated web server is advantageous in larger-scale systems for the central 
data supply to the WebNavigator Clients. The dedicated web server processes and optimizes 
client access and is available to the clients as a proxy of the WinCC servers. 

The functionality of the dedicated web server is provided by the installation of the 
WebNavigator server on a WinCC client.
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Advantages of using a dedicated web server
● The load can be distributed over several dedicated web servers in order to enhance the 

performance of the complete system.

● The physical separation of the dedicated web server and the WinCC server on different 
computers increases security.

● Operation of the servers on different stations also permits the separation of operational 
functions, for example, plant support and the IT department.

● The dedicated web server is able to provide simultaneous access to several subordinate 
WinCC servers. Users logged on to the dedicated web server can access several WinCC 
projects, without having to log on separately for each project.

● The dedicated web server supports redundancy switchover between two subordinate 
WinCC servers with WinCC Redundancy.
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4.2.4 WinCCViewerRT

Overview
You run the "WinCCViewerRT.exe" application instead of Internet Explorer on the 
WebNavigator Client. WinCCViewerRT is installed with the WebNavigator Client.

The example of WinCCViewerRT is that you do not need the browser. You therefore protect 
the system against virus or Trojan attacks.

The viewer only displays the pictures that you configured for web access and published on the 
WebNavigator Server. The user may operate or monitor the project, depending on 
authorizations. Users assigned authorization 1002 "Web access - monitoring only" in WinCC 
are only allowed to monitor the project. The WebNavigator Client is therefore a so-called "View 
Only Client". 

The "View Only Cursor" indicates that process-related operations are not possible. Certain 
operations, such as opening the properties dialog of the WinCC OnlineTrendControl, are still 
possible. 

You can also use WinCCViewerRT as terminal services application. For more information, 
refer to "Configuring terminal services for WebNavigator Server".

WinCCViewerRT does not support the "Load Balancing" function.

See also
Configuring terminal services for WebNavigator (Page 145)

4.2.5 WebNavigator Diagnostics Client

Overview         
The WebNavigator Diagnostics Client provides cost-effective access to several WebNavigator 
Servers. Several Diagnostics Clients and standard clients can be used simultaneously. This 
process does not demand an additional license for WebNavigator Server. Licensing is handled 
on the Diagnostics Client. The WebNavigator Server needs a Diagnostics Server license if a 
WebNavigator license is not already available.

The Diagnostics Client can always access the WebNavigator Server, regardless of whether 
or not the maximum number of simultaneous logins to the WebNavigator Server has been 
reached. Diagnostics Client access to the WebNavigator Server is always guaranteed.

Possible applications include:

● Remote maintenance: The Diagnostics Client is used for consecutive access to different 
WinCC systems for the purpose of service and maintenance.

● Central maintenance: The Diagnostics Client is used for simultaneous access to several 
servers.
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4.2.6 Terminal services and WebNavigator

Introduction           
The terminal services of Windows server operating systems provide access to the desktop of 
a Windows server. The Terminal Client provides screen output while the application, for 
example, WinCCViewerRT, is active on the Terminal Server.

The Terminal Services only transfer the user interface of the application to the clients. Each 
client's keyboard inputs and mouse operations are returned back to the server.

For information on redundant system configurations with the Terminal Services, refer to the 
corresponding Microsoft documentation.

Advantages of the Terminal Services
● Use of robust hardware with low memory requirements for the clients, for example, without 

fans and hard disk in a dusty environment.

● Use of mobile clients with limited power consumption, e.g. handhelds, Palmtops, or PDAs.

● All applications are located on the server in a secure environment.

● Simple, central administration and system maintenance.

● Support of different operating systems, e.g. Windows CE, Windows 95.
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4.3 Configuring the WebNavigator system

4.3.1 Overview of the configuration steps

Requirement         
● The server and client are interconnected via TCP/IP.

● On the server

– Internet Information Service is installed.

– The WebNavigator Server is installed.

– A license key is installed.

– WinCC is installed.

● On the client

– Internet Explorer is installed.
or

– WinCCViewerRT is installed.

Basic procedure
It is necessary to complete the following configurations in order to set up the WebNavigator 
system:

1. Configuration of the WinCC project.

– Publish the WinCC process pictures for web access

– Configure web settings

– Create and administer users for access of the WebNavigator Client.

2. Configuration of the WebNavigator Server.

– Configure the WebNavigator web page.

– Configure the "Load Balancing" function, if necessary.

3. Consideration of the differences compared to the WinCC basic system and of restrictions.
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4.3.2 Configuring the WinCC project

4.3.2.1 Publishing WinCC process pictures

Publishing WinCC Process Pictures

Introduction                 
If you wish to display WinCC process pictures on the WebNavigator Client or DataMonitor 
Client, you have to publish the pictures. For publishing, you use the Web View Publisher, which 
automatically makes the necessary adaptations to the project data. 

Overview
The Web View Publisher enables the following types of publishing: 

● Publishing on the local computer.
The current WinCC project folder is the source folder.
The target folder is a subfolder, for example, "Projectname/WebNavigator/Pictures".

● Publishing on a dedicated web server with a server prefix.
The source folder is the WinCC project folder on another WinCC computer that is defined 
by the server prefix.
The target folder is located in subfolder ".../WebNavigator/Pictures" of the WinCC project 
on the WinCC Client. The pictures of your own project are saved with the name 
"<picturename>.PD_", while the pictures of other projects are saved with the name 
"<serverprefix>_ _<picturename>.PD_".

● Remote publishing.
The source and target folders can be located on the same or different web servers.
You can start the Web View Publisher on the web server with the source and target folder 
or on a third web server.

● Remote publishing on a dedicated web server or WinCC Client from a different remote 
station.
The project folder of the WinCC project must be released in Windows on the dedicated web 
server/WinCC Client. You can start the Web View Publisher remotely by opening the WinCC 
project of the web server/WinCC Client on the remote computer. On the remote station, 
you publish the WinCC pictures from other WinCC Servers to the dedicated web server.

The Web View Publisher performs the following adjustments:

● Compression of the data for optimizing performance on the Internet.

● Removal of project-specific data that is not required for the operation.

● Conversion of picture windows into an ActiveX component.

● Conversion of scripts so that they can be run on the Client.
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Publication of pictures with faulty scripts
If warnings or errors are generated during publishing, the process pictures affected are marked 
in the output field of the Web Publishing Wizard. The pictures with errors in the scripts are 
nonetheless published. However, errors can still occur in Runtime and are reported by the 
WebNavigator Client. 

The "PdlPad" tool can be started directly in the Web View Publisher in order to check and, if 
necessary, correct the scripts used in the published pictures.

Publishing Without Project Functions
Publishing without project functions can be an additional source of error. When publishing with 
the Web View Publisher, the selected project functions are always published. When published 
without project functions, the pictures no longer contain any project functions. The project 
functions of the last publishing process are always available in the published pictures and, 
therefore, on the client. 

The selection of project functions in the Publisher is independent of the pictures published in 
the same process. If , for example, you modify selected project functions but not their 
interfaces, you need to publish all necessary project functions. In this case, you do not have 
to publish the picture.

Changing the process picture in Graphics Designer
Process pictures that you edit in runtime in Graphics Designer on the WebNavigator Server 
must be published once again. This is required for the process picture to be displayed on the 
WebNavigator Client.

When using a dedicated web server, open the WinCC project on that server from a remote 
station in order to transfer the changes to the WebNavigator Client. On completion, open and 
save the modified picture in Graphics Designer. Publish the picture in the next step using Web 
View Publisher on the dedicated web server. 

If you have modified a large number of pictures, you can simplify this process. For this purpose, 
call the "Convert pictures" function in the shortcut menu of Graphics Designer. On completion, 
you once again have to publish the pictures.

See also
How to publish WinCC process pictures using Web View Publisher (Page 87)

Requirements for publishing pictures (Page 86)

Requirements for publishing pictures

General requirements             
● The picture names may not contain double underscores, e.g. "__furnace_overview.pdl". 

The string before the double underscore will be interpreted as server prefix.

● The package names and/or symbolic computer names may not contain any double 
underscores. 
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● Moreover, the name cannot begin with a single underscore if you are using Basic Process 
Control. When using Picture Tree Manager, the name string of higher-level pictures will 
have a "@PTN_" prefix. With the leading underscore, the picture name will then have a 
double underscore.

● If two header files of the same name exist in the project path and in the installation path of 
WinCC, Web View Publisher will use the header file from the installation path.

Requirements for publishing on a dedicated web server
● The Web Navigator Server is installed on the WinCC Client.

● The C and VB scripts of all WinCC servers to which the WinCC Client has access have 
been copied to the WinCC Client.

● The WinCC server packages that the WinCC Client can access are loaded on the WinCC 
Client.

● If you wish to publish projects on other computers, these computers must be linked by 
means of network drive before you start Web View Publisher. This procedure enables the 
display of your projects in the selection dialog of the Publisher. You cannot enter the path 
directly.

Requirements for remote publishing
● Access to the target and source folders is enabled for Web View Publisher.

WinCC configures these Windows enables by default. Verify that these enables are not 
restricted, for example, valid for specific users only.

● If you wish to publish projects on other computers, these computers must be linked by 
means of network drive before you start Web View Publisher. This procedure enables the 
display of your projects in the selection dialog of the Publisher. You cannot enter the path 
directly.

See also
Publishing WinCC Process Pictures (Page 85)

How to publish WinCC process pictures using Web View Publisher (Page 87)

How to publish WinCC process pictures using Web View Publisher

Introduction                       
Use Web View Publisher to publish the process pictures that you created in Graphics Designer. 
The WinCC Web Publishing Wizard supports you during publishing. 
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Procedure
1. Select "Web Navigator" in the navigation window of WinCC Explorer.

Select the "Web View Publisher" command in the shortcut menu.
The WinCC Web Publishing Wizard is now launched.

2. Click "Next".
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3. Activate the "Server prefix" option if you want to publish the pictures on a dedicated web 
server.
Select the prefix of the WinCC Server that contains the WinCC project from the selection 
list. The list displays the prefixes of the servers whose packages are loaded on the WinCC 
Client.
Deleting a prefix from the selection changes the paths displayed in the fields below.

4. Under "Path to your WinCC project", select the WinCC project folder containing the pictures 
you want to publish.
The folder has the following format for publication on a dedicated web server:
"\\<servername>\<serverprefix>_ _<projectname>".
If you want to publish from a remote station, select the source project containing the pictures.
The source project is displayed by its enable name on the other WinCC Server.
The folder has the following format:
"\\<computer name>\<enable name>".

5. Select the target folder for the published pictures under "Publishing folder of the WinCC 
web".
Accept the proposed folder within the WinCC project folder.
Do not change the path specification unless you want to transfer pictures to a different 
project, for example. In this case, the prefix selection list will be expanded accordingly.
Verify the specified target project to which the published pictures are saved during remote 
publishing.   
The path definition will be updated when you select the source project.
Should the target project be located on another WinCC server, select the corresponding 
project.
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6. Select the "Display hidden objects" option to show hidden objects that are published 
automatically in the results list.

7. Click "Next". Move the pictures that you wish to publish to the "Selected files" list.
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8. Click "Next". Move the C project functions which you use in the published pictures to the 
"Selected files" list. You cannot publish individual VB scripts.

Click "Next". 
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9. Move the referenced graphics that you wish to publish to the "Selected files" list.

Click "Next". 

10.Click "Exit" to start publishing the pictures.
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Result
You have successfully published the pictures and functions. The results list displays the status 
of all published objects. You can click an object to view additional object information. 

You can trace publishing using the "<projectfolder>\WebNavigator\WizardLog.txt" file.
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Checking the scripts using "PdlPad"
The "WizardLog.txt" log file contains information about errors in the scripts used. You can also 
find errors using the "PdlPad" debugger. 

1. Open "PdlPad" by double-clicking on the affected object in the results list of Web View 
Publisher. The script of the published picture is displayed.

2. Click  in order to check the script.

3. You can temporarily correct and save the scripts. These corrections are only saved to the 
published pictures, not in the process picture of the WinCC project.

"PdlPad" can also be opened in the Windows Start menu via "SIMATIC > WinCC > 
WebNavigator-Server".

See also
Publishing WinCC Process Pictures (Page 85)

Requirements for publishing pictures (Page 86)
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4.3.2.2 Configuring web settings

Configuring runtime settings

Introduction         
You can configure the behavior in Runtime in the "WinCC web settings" dialog.

Procedure
1. Select "WebNavigator" in the navigation window of WinCC Explorer. Select the "Web 

settings" command from the shortcut menu.

2. Change to the "Runtime" tab in the "WinCC web settings" dialog.
Select the required settings. Close the dialog with "OK".

Use "WinCC Classic" design:
Select this option to improve the performance of the WebNavigator Client. The original style 
of WinCC V6 is now used.

"Monitoring only" cursor:
A default cursor shows that the user of the WebNavigator Client is not allowed to operate 
Runtime. The user has been assigned system authorization no. 1002 - "Web access - 
monitoring only" in the WinCC User Administrator.

If you want to use your own cursor, enter its path and file name. You can also use the "..." 
button to navigate to the file of the selected cursor.

WinCC/WebNavigator Documentation
4.3 Configuring the WebNavigator system

WinCC/WebNavigator
System Manual, 07/2013, A5E32316269-AB 95



Maximum number of simultaneous connections
Specify the maximum load on the WebNavigator Server. Specify the maximum number of 
connections for simultaneous access to the server. The number of configured gadgets is 
included in the count.

The number of simultaneous connections can exceed the number of WebNavigator licenses 
if, for example, several tabs are opened in the browser window. A limitation of "50" is necessary, 
since the server guarantees a maximum of 50 connections in normal operation without 
additional loads. The value must not be less than the actual number of WebNavigator licenses.

Maximum number of tabs per browser
Specify the maximum number of tabs per browser window. Multiple tabs in a browser window 
are counted as one WebNavigator license.

Activate WinCC system messages
The system messages "No. 1012400" or "No. 1012401" are output and archived at the login/
logoff of a WebNavigator Client.

Enable event log messages
A successful session login or logoff is recorded in the Windows event viewer.

Disable local groups of SIMATIC Logon
The WebNavigator Server can only be accessed by groups in the same domain.

WinCC pictures as gadget

Overview     
Gadgets are mini applications for the Windows Sidebar. On a WebNavigator Client, you can 
display published WinCC process pictures in a gadget.

Specify the WinCC pictures for the gadget. In Runtime, the WebNavigator Server successively 
generates a cyclic snapshot image "pdlImage.jpg" of each picture. The file is saved to the 
"\WinCC\Webnavigator\Server\Web\image\_gadget" folder. The gadget accesses the file at 
cyclic intervals and displays the currently generated picture.

The following objects are not displayed in a gadget:
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● Global Script Diagnostics Window

● WinCC Media Control

● WinCC Controls from migrated projects that have been installed with versions before 
WinCC V7.0

 

  Note

The pictures displayed cannot contain any user interaction. This includes calling login 
dialogs or notice dialogs by means of functions, for instance.

You cannot operate the picture that is displayed in the gadget. 
 

 
 NOTICE

Short update cycles place a high load on the WebNavigator system

Set a sufficiently long update cycle rate when an AlarmControl is displayed or a large 
number of process values for trend views are updated in the gadget.

If a process value has not yet been read from the controller at the time of the snapshot, 
the gadget displays the start value instead of the actual process value.

 

Requirement
● The Windows operating system must support the use of gadgets.

● The WebNavigator Client must be installed on the WebNavigator Server to enable 
configuration of the gadgets.
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Configuring the gadget on the WebNavigator Server 
1. Select "WebNavigator" in the navigation window of WinCC Explorer. Select the "Web 

settings" command from the shortcut menu.

2. Change to the "Gadget" tab in the "WinCC web settings" dialog.

3. Use the "..." button to select a published picture under "Name".

4. Specify the Runtime language for the selected picture.

5. Define the clipping of the selected picture that is displayed in the Gadget. As a rule, the 
process picture is too large for display in the Gadget. Ensure that the clipping has the same 
width and height as the gadget, or at least the same width/height ratio. Otherwise, the 
picture will be distorted in the gadget or displayed with a black frame.

6. Click "Add". The picture is inserted into the "Pictures" list. Repeat steps 3 to 6 for additional 
pictures.

7. Select pictures for which you want to change the language or clipping from the list. Edit the 
settings and click "Change".

8. In the "Update cycle" field, specify the time interval that is to be used by the server for the 
cyclic update of the picture that is displayed in "pdlImage.jpg".
The new picture is accessed at the start of the time interval. The current process values 
are read from the controller. At the end of the interval the snapshot is created and stored 
in "pdlImage.jpg".
The following example shows two process pictures with an update cycle of "10 s".

Time [s] Image
10 Process_Picture_1 -> pdlImage.jpg
20 Process_Picture_2 -> pdlImage.jpg
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Time [s] Image
30 Process_Picture_1 -> pdlImage.jpg
40 Process_Picture_2 -> pdlImage.jpg

1. Select the "Time stamp" option if you want the gadget to display the date and time of 
generation of the picture.

2. Close the dialog with "OK".

Displaying gadgets on the WebNavigator Client
A pre-configured gadget for displaying WinCC pictures is available in the installation folder at 
"\WinCC\Webnavigator\GADGET" on the WebNavigator Client.

To access the gadget with the WebNavigator Client, proceed as follows:

1. Double-click "WebNavigator.gadget" in the installation folder at "\WinCC\Webnavigator
\GADGET". The gadget is installed in the Windows Sidebar.

2. Specify the update cycle in which the gadget loads a picture from the WebNavigator Server.

3. Enter the address of the WebNavigator Server. The Gadget establishes a connection to 
the WebNavigator Server.

4. If necessary, drag-and-drop the Gadget onto the desktop.

Web settings for compatibility

Working with migrated projects         
The following restriction existed for C scripts in WinCC/Web Navigator prior to V6.2. Instead 
of the complete path and picture name, the following parameters and functions returned only 
the picture name on the WebNavigator Client: 

● Parameter "lpszPictureName"

● Function "GetParentPicture"

● Function "GetParentPictureWindow"

As of WinCC/WebNavigator V6.2, you can enable absolute addressing and therefore revoke 
this restriction for the WebNavigator Client, if required.

Select the desired response for the execution of C scripts:

● Picture name: Absolute addressing is disabled by default. The functions or parameters only 
return the picture name. Compatibility with older versions of WebNavigator Client and the 
C scripts created for these is maintained.

● Picture name and path: The absolute picture name is returned with the complete path.
This response corresponds with the WinCC basic system. There is no need to modify the 
C-Scripts used on the WinCC basic system for execution on the WebNavigator Client.
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Procedure
1. Select "WebNavigator" in the navigation window of WinCC Explorer. Select the "Web 

settings" command from the shortcut menu.

2. Change to the "Compatibility" tab in the "WinCC web settings" dialog.

3. Activate the desired response of the C-Scripts. 

4. Close the dialog with "OK".

4.3.2.3 Administering the users for WebNavigator Client

Introduction                       
Assign authorizations to the user for operator control and monitoring for access to a WinCC 
project as WebNavigator Client.   You can select a start picture and Runtime language for each 
user. Use the "Automatic Logout" function to specify the timeout for access of the 
WebNavigator Client to the WinCC project. The user will then be logged off automatically.
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Automatic logout
The automatic logout provides the following advantages on a WebNavigator system:

● Access from the WebNavigator client to the WinCC project is subject to timeout. This 
enhances system security, particularly when using unattended clients that access the 
WebNavigator Server.

● The license used by the client is released again after the automatic logout.

● The current load on the WebNavigator Server is reduced after the automatic logout.

Requirement
● The WinCC process pictures were published using Web View Publisher.

● WinCC User Administrator is open.

● A user is created.

● System authorizations of the user are specified.

● The domain-specific authorizations are specified if the WinCC option "Basic Process 
Control" is used.
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Procedure 
1. Select the desired user in the navigation window.

2. The user's operating authorizations are displayed in the table window.
If system authorization no. 1002 "Web access - monitoring only" has been enabled, the 
user is only allowed to monitor the WinCC project when acting as WebNavigator Client.
If this system authorization is disabled, the other operating authorizations assigned to the 
user are valid. For this reason, check the settings of the other authorizations.

3. If applicable, specify the time until automatic logout in the "Automatic Logout" field.

– Automatic logout is disabled if you enter "0" as time value.

– The time configured for automatic logout starts at the time of login if you select the 
"Absolute time" option. The time expires independent of user actions.

– If you select the "Inactive time" option, the configured time starts with the last keyboard 
or mouse operation by the user. The user is automatically logged out after this period 
of inactivity.

The "Automatic logout: disconnected from server" message is displayed after the automatic 
logout. You can refresh the page by pressing "F5" and reconnect with the WebNavigator 
Server.

4. Select the "WebNavigator" option in the table window. The "Web Options" area is displayed.

5. Click "..." to select the start picture for the user. You can only select published pictures as 
start pictures.
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6. Use the "..." button to select the Runtime language for the user. You can select one of the 
languages installed in WinCC.  

7. Close the User Administrator.

Restrictions when using SIMATIC Logon
The WebNavigator Server supports SIMATIC Logon. However, the following restrictions apply:

● If the user is a member of several user groups, a random group in which a start picture is 
configured will be selected. You cannot configure which group should be selected. The 
authorizations of all groups in which the user is a member are taken into account.

● Add the domain prefix to the user name in the login dialog of Internet Explorer: "<domain>
\<username>".

● Password expiration during a client session has no influence on the operability of the 
WebNavigator Client.

● You can only change the password on the WebNavigator Server.

● The WebNavigator Client does not support the following functions when SIMATIC Logon 
is used on the WebNavigator Server:

– Scripts

– ODK functions

– User Administrator

4.3.3 Configuring the WebNavigator Server

4.3.3.1 Configuring the WebNavigator web page

WinCC Web Configurator

Introduction                 
The WinCC Web Configurator is used to set up and manage the Microsoft Internet Information 
Service (IIS). 

Requirement
● The WebNavigator Server is installed.

● The Windows "Internet Information Service" component is installed.
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Starting WinCC Web Configurator
● Select "WebNavigator" in the navigation window of WinCC Explorer.

Click the "Web Configurator" command in the shortcut menu.

● You can also click the "Web Configurator" shortcut on your desktop.

Initial configuration using WinCC Web Configurator
During the course of initial configuration, you specify whether you wish to create a new default 
web page or a new virtual folder. 

If you only operate the Web Navigator web page on the server, select the "Create a new 
standard web page (standalone)" option.

To add the WebNavigator web page as subfolder to an existing web page, select the "Add to 
existing web page (virtual folder)" check option. This option may be necessary if the current 
default web page must remain active or if the operating system only supports operation of one 
web page.  

Managing the configuration in WinCC Web Configurator
If IIS has already been configured, edit the settings of the existing web server or the virtual 
folder using the Web Configurator.
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The Web Configurator automatically detects whether a configuration already exists. The dialog 
for editing the configuration opens if an existing configuration is found.

 

 Note
Web folder was modified or deleted

If you have deleted the web folder, restart the computer before you create a new web folder 
with Web Configurator.

Note the following:
● If web communication fails after you have changed the web folder, the Web Configurator 

attempts to adjust the settings.
● If this action is unsuccessful, proceed as follows:

1. Exit the IIS console.
2. To delete the WebNavigator web page, enter the following command line in the window 
"Run":
"<wincc_installationpath>\WebNavigator\Server\bin\WinCCWebConfigurator.exe" 
deinstall="yes".
3. Start the desired web page from the IIS console, for example, the standard web page.

WebNavigator web page under Windows XP

The "Internet Information Service" functions cannot be used to delete an independent web 
page. You cannot delete an independent web page created with Web Configurator in order 
to create the WebNavigator web page as virtual folder instead. 

Only one web page can be active under Windows XP, regardless of whether a different port 
has been assigned to every web page. If you need to open the default web page, the 
independent WebNavigator web page cannot be active at the same time. 

To delete the independent WebNavigator web page, proceed as follows:
1. Exit the IIS console.
2. To delete the WebNavigator web page, enter the following command line in the window 

"Run":
"<wincc_installationpath>\WebNavigator\Server\bin\WinCCWebConfigurator.exe" 
deinstall="yes".

3. Start the desired web page from the IIS console, for example, the standard web page.
 

Creating a new default web page

Introduction         
You can create the standard web page using the WinCC Web Configurator. 

Requirement
● The WebNavigator Server is installed.

● The Windows "Internet Information Service" component is installed.

● WinCC Web Configurator is started.
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Procedure
1. Select the "Create a new standard web page (standalone)" option and then click "Next".

2. Select "Name of the web page" and enter the name.

3. Enter the number of the port used for access in the "Port" field. HTTP port "80" is set by 
default.
If you select a different port number, that number has to be appended to the server name 
in the address bar of Internet Explorer when a WebNavigator Client logs on, e.g. 
"http://<servername>:<portnumber>".

4. At "IP address", specify whether the computer is to be available on the Intranet or Internet 
or on both networks.
Use only the addresses that are available in the selection list. 
Select "All not assigned" to enable Intranet and Internet access to the computer.

5. Select the default web page to be displayed on the WebNavigator Client after selection of 
the web server.

– MainControl.asp
Opens the WinCC Web Navigation interface and the start picture specified in the User 
Administration. You need the Web Navigation interface to download plug-ins, for 
example.

– WebClient.asp
Opens the start picture you specified in the User Administration.

6. Specify the time interval for automatic connection setup after a connection failure.
A time setting of "0" disables the "Automatic reconnection" function.
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7. Specify whether the web page is started once the configuration is completed.

8. Click "Finish" if you have not activated a Firewall. Click "Next" if you have installed a Firewall.

Result
You have successfully created the web folder and activated the web page. 

See also
Configuring the Firewall (Page 109)

Creating a virtual folder

Introduction     
You can create a virtual folder using the WinCC Web Configurator.

Requirement
● The WebNavigator Server is installed.

● The Windows "Internet Information Service" component is installed.

● WinCC Web Configurator is started.

Procedure
1. Enable "Add to existing web (virtual folder)". Click "Next".

2. Select the active web page to which you want to add the virtual folder.
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3. Click "OK" to close the dialog.
Click "Next" in the next dialog.

4. Select "Name of the web page" and enter the name.

5. Web Configurator applies the IIS settings as port number and IP address.

6. Select the default web page to be displayed on the WebNavigator Client after selection of 
the web server.

– MainControl.asp
Opens the WinCC Web Navigation interface and the start picture specified in the User 
Administration. You need the Web Navigation interface to download plug-ins, for 
example.

– WebClient.asp
Opens the start picture you specified in the User Administration.

7. Specify the time interval for automatic connection setup after a connection failure.
A time setting of "0" disables the "Automatic reconnection" function.

8. Specify whether the web page is started once the configuration is completed.

9. Click "Finish" to complete the configuration.

Result
You have created the virtual web folder and the web page is activated. 

On the WebNavigator Client, add the name of the virtual web folder to the URL to enable 
access to the web page, e.g. "http://WebServer/WebNavigator".
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No active web page
If no active web page is found, the Web Configurator terminates with a message.

Activate a web page before you restart the Web Configurator. For more information, refer to 
"Checking the activated web page".

See also
Configuring the Firewall (Page 109)

Check the activated web page (Page 114)

Configuring the Firewall

Configuring the Firewall in Windows XP/Windows 2003

Introduction       
This section describes how to activate the "HTTP" or "HTTPS" services and the procedure for 
other port settings in Windows XP or Windows 2003.

Requirement
● A default web page was created using the Web Configurator.

● The Firewall is activated.

● The user who is logged has Windows administrator rights.

● You have to set up the HTTPS service in IIS if you are using it for WebNavigator. For more 
information, refer to "Setting up an HTTPS service in IIS (http://support.microsoft.com/kb/
324069)".
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Procedure for the default port
1. Click the "Windows Firewall" button in the Web Configurator.

The "Windows Firewall" dialog opens.

2. Click the "Advanced" tab.
Select the required network connection and then click the "Settings" button.
The "Advanced Settings" dialog opens.
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3. Select the "Secure Web server (HTTPS)" or "Web server (HTTP)" check box.
Click the "Edit" button to display the current service settings for the web server.

4. Close all Windows dialogs with "OK".

5. Click "Finish" in the Web Configurator. The server configuration is completed.
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Procedure for other port settings
Customize the Windows Firewall settings as follows if you are not using the default port.

1. Click the "Windows Firewall" button in the Web Configurator. The "Windows Firewall" dialog 
opens.

2. Click the "Advanced" tab.
Select the required network connection and then click the "Settings" button. The "Advanced 
Settings" dialog opens.

3. Click "Add" in the " Advanced Settings" dialog.
The "Service Settings" dialog opens.
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4. Specify the web server settings:

– Web server name in the "Service description" field

– Name or IP address

– External and internal port number for this service

– "TCP" service

Confirm with "OK".

5. Activate the web server you created in the "Advanced Settings" dialog.

6. Close all Windows dialogs with "OK".

7. Click "Finish" in the Web Configurator. The server configuration is completed.

Configuring the Firewall in Windows 7/Windows 2008

Introduction       
The chapter describes how to activate "HTTP" and "HTTPS" services for port "80" in Windows 
7 or Windows 2008.

Consult your network administrator if you want to set up the Windows Firewall with advanced 
security or for a different port.

Requirement
● You have created a default web page with Web Configurator.

● The Firewall is activated.

● The user who is logged has Windows administrator rights.

● You have to set up the HTTPS service in IIS if you are using it for WebNavigator. For more 
information, refer to "Setting up an HTTPS service in IIS (http://support.microsoft.com/kb/
324069)".

Procedure for the default port
1. Click the "Windows Firewall" button in the " WinCC Web Configurator".

The "Windows Firewall" dialog opens.

2. Windows 7: Click "Allow a program or feature through Windows Firewall".
Windows 2008: Click "Allow a program to communicate through Windows Firewall".

3. Activate "Secure WWW services (HTTPS)" or "WWW services (HTTP)".

4. Close all Windows dialogs with "OK".

5. Click "Finish" in the Web Configurator.
The server configuration is completed.
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Check the activated web page

Procedure in Windows XP/2003       
1. Select "Programs > Administration > Internet Information Services" from the Windows Start 

menu. The "Internet Information Services" editor opens.

2. Click on the plus symbol next to the computer name in the "Structure" field.

3. Click on the plus symbol next to "Websites". The data window displays the corresponding 
web pages.

4. Check the view of the web pages.
If the status "Stopped" is displayed next to the required web page, for example, 
"WebNavigator", start the web page. 
Select the "Start" command from the shortcut menu to launch the web page.

5. Close the editor. The web page is activated.
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Procedure in Windows 7/2008
1. Select "All programs > Administration > Internet Information Services (IIS) Manager" from 

the Windows Start menu.

2. Click the computer name in the "Connections" field.

3. Click "Default Web Site".

4. Check the view of the web pages.
If the status "Stopped" is displayed next to the required web page, for example, 
"WebNavigator", start the web page.
Select the "Start" command from the shortcut menu to launch the web page.

5. Close the "Internet Information Services (IIS) Manager". The web page is activated.

4.3.3.2 Load Distribution Using the "Load Balancing" Function

Load balancing on WebNavigator Servers

Overview         
The "Load balancing" function allows you to automatically distribute the WebNavigator Clients 
evenly to different Web Navigator servers. All WebNavigator Servers can participate in load 
balancing using their respective server license. 

A WebNavigator Server can act either as Load Balancing Server or only as participating 
WebNavigator Server. 

A Load Balancing Server is automatically a participating WebNavigator Server, too. 
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Several Load Balancing Servers can be configured in a group of participating WebNavigator 
Servers. 

Load balancing sequence
Following the login of a WebNavigator Client, the Load Balancing Server transfers the client 
to the participating WebNavigator Server with the lowest load. 

The clients are allocated using the "LBConfig.xml" file. The file is available in the "Project folder/
WebNavigator". 

If the fewest clients are logged on to the Load Balancing Server, the new client remains 
connected to that server. 

If a participating WebNavigator Server fails, the clients logged on to it remain in the Reconnect 
Screen until this Webserver is available again. 

The address of a WebNavigator Server does not depend on whether it is activated as a Load 
Balancing Server. 

Licensing
The "Load balancing" function supports a maximum of 32 interconnected WebNavigator 
Servers. 

All participating WebNavigator Servers and Load Balancing Servers need a "Load balancing" 
license. 

No license is necessary on the WebNavigator Clients. 

When using WinCC computers with WinCC Redundancy, you can operate a Load Balancing 
Server or participating WebNavigator Server using the "WinCC Redundancy" and "Load 
Balancing Step-Up" licenses. 
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Example

In the figure, WebNavigator Servers 1 to 3 participate in "Load Balancing". A "Load Balancing" 
license is installed on the WebNavigator Servers. 

WebNavigator Servers 1 and 2 are configured as Load Balancing Server. 

When WebNavigator Client 1 logs on to WebNavigator Server 1 or 2, it is routed automatically 
to the server that is with the lowest load.

If the WebNavigator Server to which it is connected fails, Client 1 is re-routed to one of the 
remaining WebNavigator Servers. 
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WebNavigator Server 3 participates in "Load Balancing", but it is not configured as Load 
Balancing Server. 

In the case of a high load or on the failure of Server 1 or Server 2, the WebNavigator Clients 
can be re-routed to Server 3. If WebNavigator Server 3 fails, the client cannot be re-routed to 
Server 1 or 2, irrespective of any active connection.

WebNavigator Server 4 does not participate in "Load Balancing". A logon of WebNavigator 
Client 2 to this server will possibly fail because load limits are exceeded on the server. On 
failure of WebNavigator Server 4, the client cannot be re-routed to one of the WebNavigator 
Servers 1 to 3, irrespective of any active connection. 

Settings for the use of a proxy server
The use of a proxy server may have the effect that the target address "http://<servername>" 
of the participating WebNavigator Server or Load Balancing Server is replaced with "http://
<servername.proxyname>". 

The addressed WebNavigator Server will  not be found. For this reason, you must enter the 
target addresses on the servers involved of all other participating servers in Internet Explorer. 
Enter the addresses in "Tools > Internet Options > Connections > LAN Settings > Advanced", 
"Exceptions" field. 

 

 Note

The "WinCCViewerRT.exe" application does not support "Load Balancing".
 

See also
Configuring the "Load Balancing" Function (Page 118)

Configuring the "Load Balancing" Function

Introduction         
You need a license on each participating WebNavigator Server and Load Balancing Server. 

All Load Balancing Servers and participating WebNavigator Servers are included in the list of 
Load Balancing Servers. 

The order of all listed participating servers must be identical on all Load Balancing Servers. 

Set up the query interval and activate the "Load Balancing" function. 
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A configuration is not necessary on the WebNavigator Clients.
 

 Note
Identical lists of participating WebNavigator Servers

The lists on the Load Balancing Servers and all participating WebNavigator Servers must be 
identical to ensure uniform functionality in the case of the failure of a WebNavigator Server.
Settings for a migrated project

The "Load Balancing" settings are saved for each specific project. You need to save the 
settings once again in order to activate these for a migrated project. Start the configuration 
dialog and confirm the settings with "OK".
WebNavigator Server with "WebNavigator Diagnostics Server" license

A WebNavigator Server with "Web Navigator Diagnostics Server" license cannot be included 
in the list of servers that participate in Load Balancing.

 

Requirement
● The WinCC basic system, WebNavigator Server and a "Load Balancing" license are 

installed.

● The same users are configured on all participating WebNavigator Servers and Load 
Balancing Servers.

● The default web page for WebNavigator must have been created as "standalone" on the 
WebNavigator Server.
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Procedure
1. In WinCC Explorer, select the "Load Balancing" command from the "WebNavigator" 

shortcut menu. The "Load Balancing Configuration" dialog is opened.

2. In the top field, enter the address of a WebNavigator Server that participates in "Load 
Balancing". Click "Add" to include the address in the list of servers.
Repeat the process for each WebNavigator Server that participates in "Load Balancing". 
Supplement the name of the Load Balancing Server in the list.
You can always remove a server name from the list. Select a name from the list and click 
"Remove".

3. Select the "Enable Load Balancing" check box to activate the local WebNavigator Server 
as Load Balancing Server.
The check box remains deactivated on the participating WebNavigator Servers.
The list of servers is retained even when you clear the check box. 

4. In the "Polling Interval" field, select the time interval for polling the other participating 
WebNavigator Servers. The time interval is only relevant on a Load Balancing Server.

5. Click "Save".
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6. Close the dialog with "OK".

7. Repeat the procedure on all participating WebNavigator Servers and Load Balancing 
servers.
The modifications take effect when WinCC Runtime is restarted.

4.3.4 Differences to the WinCC Basic System

4.3.4.1 Functional restrictions

Introduction     
The WebNavigator has certain functional restrictions compared to the WinCC basic system. 
You should therefore check your WinCC projects for these restrictions and adjust the project 
settings as required.

Overview
When you use functions that are not supported in a project, corresponding messages are 
generated in Runtime to draw your attention to the fact.

The following restrictions apply to the WebNavigator Client:

● The client provides only a view of the running WinCC project.
It is not possible to configure the WinCC Server projects.

● You can only use WinCC options and WinCC add-ons if specified explicitly in the 
documentation.

● Not all "Runtime API functions" are supported.
A list of supported functions is available at "Supported functions (Page 150)".

● For information on restrictions in combination with Basic Process Control, refer to "Options 
for Process Control > Overview of process control system options > Configuring in the PCS 
7 environment > Web Client in the WinCC Information System.

● The WinCC reporting system is not supported. This means that reports can only be output 
on the Web Navigator Server and WinCC Client.

● You cannot use the print function in the WinCC Controls.
Instead, use the WinCC hardcopy function to print. You can find out how to use the hardcopy 
function at "Using the "Hardcopy" function (Page 139)".
The following FAQ shows how to transfer coordinates, for example, to print the 
TrendControl only: FAQ 21606152 (http://support.automation.siemens.com/WW/view/en/
21606152)

● The message archive and message system can only be operated and monitored. You 
cannot modify the selection of archives and tags for the visualization of the process values.
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● The "WinCC Alarm Control" function does not support the "triggers an action" property for 
a message.
For the correct display of message blocks, the "Apply project settings" option cannot be 
activated. You can find this option on the "Message blocks" tab of the "WinCC AlarmControl" 
properties dialog.

● The hotkeys configured in WinCC are not supported.
Operator control using the tab key is supported.

● The following objects contained in the "Global library/Operation/Operating panels" folder 
of the WinCC shared library are not supported:

– 1_Slider

– 2_Slider

– 4_Slider

● National special characters in names of process pictures or referenced graphics are not 
supported on the Internet.

● The overlap lock in process pictures is not supported.

● The advanced zoom functions cannot be disabled. If you do not want to employ the zoom 
functions, do not use a wheel mouse with "auto-scroll" setting on the client.

● The redundancy switch is only supported on the dedicated web server.

4.3.4.2 Using Scripts

Scripts running exclusively for the WebNavigator               
In order to execute scripts only for the WebNavigator, use the pre-processor definition 
"RUN_ON_WEBNAVIGATOR" in the script. For example: 
void OnOpenPicture (char* lpszPictureName, char* lpszObjectName, 
char* lpszPropertyName)
{
#ifdef RUN_ON_WEBNAVIGATOR
// here you enter the code that is to be executed only in the 
WebNavigator
#else
// here you enter the code that is executed only in the WinCC basic 
system
#endif
}

Visual Basic Script
There are only slight restrictions imposed by unsupported functions when VBS is used. A list 
of these functions is available at "Unsupported functions (Page 160)".

Global Script
You configure the scripts on the WinCC Server in the server project. 
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Global scripts cannot be executed on the WebNavigator Client. Global Scripts on the server 
are supported.

The scripts generated using the Dynamic Wizard cannot contain unsupported functions and, 
therefore, cannot be executed on the WebNavigator Client. Check and correct the scripts, if 
necessary. Add the following condition, for example: "#ifdef RUN_ON_WEBNAVIGATOR". 

Script with trigger tags
The WebNavigator queries tags at cyclic intervals of "1 second". The update cycle of trigger 
tag "upon change" is also one second. 

This may lead to an increased communication load between the AS and WinCC Server. Take 
increased loads into account if communication between the AS and WinCC Server is operated 
at load limits. 

If tag-triggered scripts request additional tags having a name that is generated using a string 
function, for example, unknown tags can only be read synchronously. Enter the tag names 
you are using in the trigger list in order to avoid extended selection times. 

Script for picture selection and deselection 
In contrast to the basic system, a picture is downloaded in asynchronous mode when 
WebNavigator is used. Account for this fact when using scripts that contain picture changes. 

If a picture selection for a picture window is initiated within a script, you cannot access the 
objects of the new picture within the same script afterwards. The picture is not yet loaded at 
this time. A time delay, e.g. "Sleep(2000)" is of no help since the script and Internet Explorer 
are waiting. You should then execute the next script elements in the "OpenPicture" function 
that is triggered after the picture is loaded.

Other functions called in the script following a picture deselection will be executed with errors 
or not at all. The picture context is lost due to the picture deselection.

Synchronous script functions
Synchronous script functions impose a heavy load on the system. 

You should therefore refrain from using the "SetTagxxx" function in cyclic scripts. The server 
will be overloaded when many clients call the "SetTagxxx" functions in a fast cycle, e.g. 1 sec 
or less.

Note that the following script functions and calls are transferred synchronously to the server:

● Functions that write a tag in synchronous mode and then wait for the result, e.g. "xxxWait"

● C-API calls

The frequent use of these scripting functions and calls has a negative effect on the performance 
of the WebNavigator Client. In the case of an Internet connection, the duration of these calls 
may even be in the seconds range.

Script functions that manipulate the objects in the displayed picture are of no concern since 
no data traffic takes place between the client and server.
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Picture in picture method and cyclic scripts 
Many synchronous calls in a picture may reduce performance, for example, in the following 
cases:

● More than ten windows are configured in a picture window.

● Cyclic scripts with synchronous calls, for example, "SetTagxxx", are used in the windows.

Execution of certain scripts may fail due to timeout. 

The following elements are supported in a window:

● 16 windows with cyclic scripts.

● 31 windows without cyclic scripts.

4.3.4.3 Using tags

Computer-local tags         
The WebNavigator Client supports computer-local tags with the following restrictions:

● When a dedicated web server is used, only the computer-local tags of that server are 
available on the client. The tags on the client cannot assume their own values.

● Computer-local tags of the subordinate WinCC servers cannot have their own values on 
the client.

● The start value of computer-local text tags can only contain characters that are allowed in 
tag names. If the start value of a text tag contains a colon, for example, the tag is not 
recognized on the client.

● Computer-local tags are not supported on the client when User Archives are used, because 
User Archives can only identify the local tags of the server, but not the tags of the 
WebNavigator Client.

Defining picture-local script tags
Do not use WinCC tags for WebNavigator if picture-specific data is stored in scripts. 

The reading or writing of data in scripts always generates data traffic to the server. This places 
a load on the communication. 

You can save picture-specific data as follows:

● Configure "hidden" graphic objects so that you can use their properties as picture-specific 
tags. Actions are executed at the object properties upon changes to the stored values.

● You have created the hidden "static text" object, for example. The "Text" property is used 
to store any texts, while the color properties are used to store any colors. The properties 
are read and/or written using scripts and influence the picture status without requiring a 
roundtrip to the server.
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4.4 Operating the WinCC project

4.4.1 General properties of the WebNavigator Client

Automatic connection setup after connection interruption               
If communication between the WebNavigator Client and WebNavigator Server goes down, a 
message is output to the user on the client. 

The client performs an automatic connection establishment. Upon successful connection 
setup, the start page of the WinCC project is selected. Specify the time interval between 
attempts to set up a connection in the Web Configurator. 

If a Firewall or proxy server is used in client/server communication, the client logon may be 
successful, but automatic reconnection will not work. When attempting to reconnect, the client 
uses "ICMP Ping", which may be blocked by the Firewall or proxy server. In this case, 
deactivate the use of "ICMP-Ping" by the client for reconnection. The "Reconnect > Deactivate 
ICMP Ping" setting is available under "Settings > WebClient Properties" in the Web Navigation 
interface or via the "ClientConfig.asp" page.  

Contents of the address bar
Character strings which cannot be interpreted and are not relevant to the user are displayed 
on the address bar of Internet Explorer. For example, the "loadbalancing=no" entry may 
appear, but it does not represent a status indication for the servers participating in Load 
Balancing. 

Enter characters in the address bar when logging on and check the server name and port.

Login by means of direct input in Internet Explorer
The Microsoft Security Patches for Internet Explorer now prevent the WebNavigator Client 
login by input of the user name and password in the address bar.

"AutoComplete" entries and links in the progress bar
The entries in the address bar of Internet Explorer are displayed as a link in the progress bar 
or suggested as "AutoComplete" entries for subsequent input. However, you cannot use these 
functions without verification when a WebNavigator Client logs on to a WebNavigator Server 
with Load Balancing. 

At its initial login on a server with Load Balancing, the client is re-routed to a second server. 
Internet Explorer displays the address of the second server in the progress bar or as an 
"AutoComplete" entry. The link in the progress bar or the "AutoComplete" is applied without 
verification at the next client login. The client is then logged on to the second server.
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WebNavigator Client with several power users
Once a power user has installed a new WebNavigator Client version on a computer, all other 
power users of this computer must upgrade to the new version.

Inconsistency of the versions employed by power users may lead to problems.

This also applies when a power user connects to a server that hosts an older version of 
WebNavigator.

Persistency in Runtime
The persistency data for pictures and objects is stored in each case on the WebNavigator 
Client. Observe the following points when working on the server with several projects that 
contain pictures or objects of the same name:

If you create a persistency for a project picture in Runtime, that persistency is also applied to 
the picture of the same name in other projects.

The persistency settings you defined once for a server picture on the dedicated web server 
will be applied to the respective WebNavigator Client.

Persistency for WinCC Controls
In Controls for WinCC V7 or later, reset the settings in the Control properties on the "Online 
Configuration" tab.

The persistency files for Controls prior to WinCC V7 are located in the folder "Documents and 
Settings/User/Application Data/Siemens/SIEMENS.WINCC/WebNavigator/Client" on the 
WebNavigator Client. 

You have the following options of undoing the settings in the Controls in which Runtime 
persistency was activated:

● Resetting individual settings in the Control.

● Deleting the file.

Text changes in the text library
If you change a text from the text library in Runtime, the WebNavigator Client does not 
automatically detect this. In order to refresh the displayed pictures, reload the picture in Internet 
Explorer using the "Refresh" icon or the "F5" key.

Language-dependent texts as text references
Language-dependent texts via text references are displayed on the WebNavigator Client in 
the language currently set on the associated WinCC Server.

The same applies to a WinCC Client with its own project on which text references of a second 
WinCC Server have been loaded by means of packages. If a WebNavigator Client is logged 
on to this WinCC Client, the text references of the second WinCC Server are displayed on the 
WebNavigator Client in the current language of the server.  
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WinCC Slider Control
Set the "Continuous_Update" property to "No" when using the WinCC Slider Control. If you 
set this property to "Yes", the slightest change to the position generates an event trigger. This 
setting causes a heavy communication load on the WebNavigator Client.

Removing the ProTool/Pro software
The Controls of the HMI Symbol Library are deregistered if you remove the ProTool/Pro 
software on a WebNavigator Client. Reinstall the WebNavigator Client in order to recover 
access to the Controls.

Access of the WebNavigator Client to a WinCC flexible Sm@rt Server
A WebNavigator Client can call the "Change server" function using the Web Navigation 
interface to access a WinCC flexible Sm@rt Server. 

4.4.2 Process pictures on the WebNavigator Client

Picture change on dedicated web server 
If a picture with a server prefix was loaded on the dedicated web server, no picture of the local 
WinCC project can subsequently be displayed without server prefix. 

To display a picture of the local client project, use the server prefix "@local" for addressing, 
e.g. "@local::picture123.pdl". 

When executed, the OpenPicture() function opens the higher-level picture of the executing 
object on the dedicated web server.

Project functions in pictures
The project functions are loaded when a project is initially selected after the start picture has 
been loaded. 

For this reason, a delay may be generated between the initial display of the start picture and 
execution of operator actions. Although the picture is displayed, it cannot be operated until a 
delay of approximately 1 second has expired. 

Picture window on the WebNavigator Client
After you rename a picture in a picture window, the "Object change" event of the picture window 
is executed several times on the WebNavigator Client. 

The event is executed only once in the WinCC basic system. 

This response on the client is system-related, because the asynchronous operating principle 
of the Internet connection may trigger multiple updates of the picture window object. This 
response has no implications in terms of functionality.
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WinCC web browser OCX on the WebNavigator Client
● The "Allow ActiveX Controls" check box has to be activated in the "Security" tab in the 

Internet options of Internet Explorer.

● If you select a link in a process picture on the WebNavigator Client using the WinCC web 
browser, the "Back" button will not work during the initial display of the linked page. The 
function is not properly executed until the page is called a second time. The incorrect 
behavior persists after a change of the process picture.

● The WinCC web browser serves to display static web contents or CHM documents in 
process pictures. Contents with scripting functionality are not supported.

● If you want to disable the right mouse button in the WinCC web browser to prevent the 
WinCC Client from accessing the shortcut menu, proceed as follows:

– Use Microsoft "Group Policy Object Editor" (Gpedit.msc).

– Select the path "\Windows Components\Internet Explorer\Browser menus" and set the 
shortcut menu to "Disabled".

Performance when using WinCC UserArchiveControl         
Changes to a user archive trigger the update of the WinCC UserArchiveControl that is 
displayed. The following factors affect the performance of the process pictures with WinCC 
UserArchiveControls on the WebNavigator Client:

● Reduce the number of WinCC UserArchiveControls that simultaneously access a user 
archive to the minimum.

● Do not configure more than the necessary number of cyclic changes in the user archive.
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4.4.3 Operating the WinCC project with Internet Explorer

4.4.3.1 Operating the WinCC project with Internet Explorer

Requirement     
● On the server

– The WebNavigator Server is installed.

– The "WinCC WebNavigator" license is installed.

– The WinCC pictures are configured and published for web access.

– A user for the WebNavigator Client was created in WinCC User Administrator.

– A start picture was specified for the user in the User Administrator.

– The WinCC project is in Runtime.

● On the client

– The WebNavigator Client is installed.

– Internet Explorer is installed.

Procedure
1. Go to the address bar of Internet Explorer and enter the address "http://

www.<servername>" of the WebNavigator Server.

2. Confirm your entries.

3. Type in the user name and password. Confirm your entries.
 

  Note

Passwords are case-sensitive.
 

Result
The default web page is displayed. The view depends on the configuration:

● With "WebClient.asp" setting for the default web page, the WebNavigator Client starts with 
the start picture that is specified for the user.

● With "MainControl.asp" setting for the default web page, the WebNavigator Client starts 
with the start picture that is specified for the user plus the WinCC Web Navigation interface.

See also
Administering the users for WebNavigator Client (Page 100)
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4.4.3.2 Working with the WinCC Web Navigation interface

Menu of the WinCC Web Navigation interface   
In addition to the start picture, the WebNavigator Client displays the WinCC Web Navigation 
interface when "MainControl.asp" is configured as the default web page.

The Web Navigation interface provides a compilation of different web functions in its menus:

● "Change server": Changes to a different WebNavigator Server.

● "Used servers": Navigates to the web servers used previously.
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● "<Name of the current server>" (e.g. "MyProject", or "localhost"):

– Process pictures: Display or picture navigation of the current WebNavigator Server.

– Diagnostics: "Status.html" for diagnosing the WinCC project and the connection to the 
WebNavigator Server.

– Additional tools: Can be expanded by the user, e.g. "DataMonitor".

– Download area: Expansions for WebNavigator and plug-ins that were created using 
WinCC Plug-In Builder.
The plug-ins are available at "WebNavigator/Server/Web/Install/Custom" in the 
installation folder on the WebNavigator Server.

● "Settings": Setting for the WebNavigator Client, e.g. size of the process picture or activation 
of the screen keyboard.

● "Current": Links to web pages such as "SIMATIC HMI", "WinCC", or "WinCC flexible".

● "Language": Language change function for the WinCC Web Navigation interface
Five languages are available by default. You can customize the language options in the 
"Menu.xml" file. 
The languages are stored in CSV file format in the "_languages / <language_identifier>" 
subfolder on the WebNavigator Server. In order to add languages, reference the language 
files in the "mainControl.asp" file.

4.4.3.3 Expanding the WinCC Web Navigation interface

Introduction   
The menu of the Web Navigation interface may be expanded by additional entries and 
functions. 

Configure the expansion in an XML file. This file is saved to the "_custom_data" subfolder on 
the WebNavigator Server. You can give the file any name you choose, since all files with "XML" 
extension are processed in this folder.

Example
The following example adds the "My Private Menu" submenu to the "Server" menu. The 
submenu consists of three entries, namely "My Link", "Relative Link" and "Run Script". 

Code Description
<?xml version="1.0"?> Version information
<menu hook-on="server"> The "menu hook-on" command is used to reference the name 

"server" that defines the "Current Server" menu on the Web 
Navigation interface.

<caption><lng>My Private Menu</lng></caption> Defines an empty entry.
<command>
<caption>My Link</caption>
<open-url target="right">http://www.msdn.com</open-url>
</command>

Defines the "My Link" entry with a direct link.
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Code Description
<command>
<caption>Relative Link</caption>
<open-url target="right">project.asp</open-url>
</command>

Defines the "Relative Link" entry with a relative link.

<command>
<caption>Run Script</caption>
<run-script>alert("Hallo !")</run-script>
</command>

Defines the "Run Script" entry that is used to start scripts.

</menu> End of menu.

4.4.3.4 Diagnosis of the Connections with "Status.html"

Introduction
The "Status.html" page is used to diagnose the WinCC WebNavigator Server and its connected 
active clients.     

Overview
Call the diagnostics page as follows:

● Type in the address "http://<servername>/status.html" in Internet Explorer if WebNavigator 
is configured as the default web page.

● Type in the address "http://<servername>/<foldername>/status.html" in Internet Explorer if 
WebNavigator is configured as virtual web page.

● Select the "Status" command from the "Diagnostics" menu if the Navigation interface is 
available via "MainControl.asp".

Access to this page is restricted to the users created in the User Administrator.
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Structure of diagnostics information related to the WebNavigator Server

Field Description
Server version WebNavigator Server version
Server file date Date of the server version
License count Number of licenses on the WebNavigator Server
Runtime mode Status of WinCC Runtime
Last update Date and time of the last display refresh 
Connected WebNavigator Clients Number of connected WebNavigator Clients 
Connected Diagnostics Clients Number of connected Diagnostics Clients
Connected DataMonitor Clients Number of connected DataMonitor Clients 
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Structure of diagnostics information related to the connected clients
The diagnostics information starts with the name of the relevant client.

Field Description
Logged on users Number of connected clients 
Login Login name of the current user
Time Login time of the current user or time of the most recent automatic connection setup. 
Type Type of client, e.g. standard, DataMonitor
PID  Process ID of the instance of WebNavigatorRT.exe on the web server communicating 

with the client.
 

 Note

You can save the status information that is displayed. To do this, use the "Save as" function 
in Internet Explorer and select the "(*.txt)" file type. If "(*.htm, *.html)" are selected, the 
contents displayed are not saved. 

 

 

4.4.4 Operating the WinCC project using WinCCViewerRT

4.4.4.1 Configuring WinCCViewerRT

Introduction           
WinCCViewerRT is a program for visualizing WinCC projects. You can configure 
WinCCViewerRT for operation with the WebNavigator Server and Graphics Runtime.

Requirement
● On the server

– The WebNavigator Server is installed.

– A WinCC/WebNavigator license is installed.

– The WinCC project is in Runtime.

– The WinCC pictures are configured and published for web access.

● On the client

– The WebNavigator Client is installed.

WinCC/WebNavigator Documentation
4.4 Operating the WinCC project

WinCC/WebNavigator
134 System Manual, 07/2013, A5E32316269-AB



Procedure
1. Double-click the link "WinCCViewerRT.exe" in the "Webnavigator\Client\bin" installation 

folder.
The configuration dialog opens if you reconfigure WinCCViewerRT. 
WinCCViewerRT opens if WinCCViewerRT has already been set up. Use the <Ctrl+Alt+P> 
key combination to open the configuration dialog of WinCCViewerRT.

2. Enter the login data in the "General" tab:

– Server address: http://<server name> or http://<IP address>

– User name and password, if you want to specify a default user for the login dialog.

– The user settings you configured in the User Administrator will be activated if you enable 
the "Apply project settings" option.

3. Specify the Runtime language in the "Parameters" tab.
If necessary, disable any key combinations with which the user switches to other programs. 
If required, you can modify the preset <Ctrl+Alt+P> key combination that is used to open 
the WinCCViewerRT configuration dialog.
Define a key combination with which a user can log off and a new user can log on. The key 
combination can only be used if no default user has been set in the "General" tab.
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4. Specify the WinCC Runtime properties in the "Graphics Runtime" tab:
- Start picture
- Configuration file for user-defined menus and toolbars
- Window attributes
- Impermissible user actions

WinCC/WebNavigator Documentation
4.4 Operating the WinCC project

WinCC/WebNavigator
136 System Manual, 07/2013, A5E32316269-AB



5. Specify additional user actions in the "Runtime" tab:
‑ Activating the screen keyboard
‑ <Ctrl+Alt+Del> key combination to allow switching to the Task Manager or operating 
system via the screen keyboard.
- Auto-logoff settings

6. Close the dialog with the "OK" button.

Result
WinCCViewerRT is configured. The connection to the WebNavigator Server is set up after you 
close the dialog. The settings are saved to the "WinCCViewerRT.xml" configuration file. The 
configuration file settings are used at the next start of WinCCViewerRT. WinCCViewerRT 
applies the user interface language from WinCC.

The configuration file is saved in the folder "Documents and Settings\<User>\Application Data
\Siemens\SIMATIC.WinCC\WebNavigator\Client". You can rename the file, for example, to 
"User1.xml". You can also start WinCCViewerRT by means of the command line with the user-
specific configuration file, e.g. "WinCCViewerRT.exe User1.xml". This procedure allows for 
different configurations, depending on the logged-on user. 

The WinCCViewerRT configuration dialog opens at the start if you rename or delete 
"WinCCViewerRT.xml". Reconfigure WinCCViewerRT or select a different configuration file.

 

 Note

WinCCViewerRT can only be closed by means of script function if you disable a key shortcut 
or hide the "Close" button. Function in the C-Script: DeactivateRTProject; function in the 
VBScript: HMIRuntime.Stop.
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4.4.4.2 Operating the WinCC project

Requirement       
● On the server

– The WebNavigator Server is installed.

– The "WinCC WebNavigator" license is installed.

– The WinCC project is in Runtime.

– The WinCC pictures are configured and published for web access.

– The user is created in WinCC.

● On the client

– WinCCViewerRT is configured.

Procedure
1. Start "WinCCViewerRT" in the Windows Start menu with "Programs > Siemens Automation 

> Options and Tools > HMI Tools".

2. Log on to the WebNavigator Server:

– A login dialog is not displayed if the user name and password is preset in the 
"WinCCViewerRT" configuration dialog. You are logged on automatically with the stored 
login data.

– The login dialog is displayed if a user name and password is not set in the 
"WinCCViewerRT" configuration dialog. Enter the user name and password of the 
WinCC user. Passwords are case-sensitive. Click "OK".

3. To change the user, use the specified key combination for "WinCCViewerRT" login/logoff. 
The previous user is logged off. Enter the user name and password of the new WinCC user 
in the login dialog. Passwords are case-sensitive. Click "OK".
The key combination can only be used if no default user has been set.

Result
WinCCViewerRT automatically connects to the activated WinCC project. The start picture that 
is configured for the user is displayed. 

The user may operate or monitor the project, depending on authorizations. Users assigned 
system authorization No. 1002 "Web access - monitoring only" in the User Administration are 
only allowed to monitor the WinCC project.

The "View Only Cursor" indicates that process-related operations are not possible. 
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Certain operations, such as opening the properties dialog of a WinCC OnlineTrendControl, 
are still possible. 

You can also use your own cursor icon as a "View Only Cursor", if required. For more 
information, refer to "Configuring Runtime settings (Page 95)".

The <F5> key triggers a reselection of WinCCViewerRT.

4.4.5 Using the "Hardcopy" function

Introduction       
On the WebNavigator Client, the current view can be output to the default printer.

You can generate a screenshot using a configurable key combination or a script. You can enter 
the definition of the key combination or the screen area to be printed via the command line, 
for example. 

Starting the hardcopy application
Start the "PrtScr.exe" application on the WebNavigator Client, for example, by means of the 
command line input or a user-defined function. The application is stored in the "...\Common 
Files\Siemens\BIN" folder. 

The parameters are transferred once only at the start. Separate the parameters with a space. 
Observe case sensitivity.

Close the application before you edit the parameters. Edit the parameters and restart the 
application.

The following parameters specify the procedure for printing a screenshot:

Parameters Function
Without parameters Not allowed on the WebNavigator Client. 

Use "-infinit" as a substitute. Example: PrtScr.exe –infinit –hotkey="<ALT>+p"
-end Terminates an active instance of PrtScr.exe.
-hardcopy Starts PrtScr.exe. Generates a screenshot of the current view. The hardcopy function then waits 

for the key combination for output to the printer.
Use this on the WebNavigator Client only in combination with the "infinit" and "hotkey" parameters.

-nomcp Starts PrtScr.exe. Generates a screenshot and prints the current view. PrtScr.exe is then closed.
-C= left;top;right;bottom Starts PrtScr.exe. Generates a screenshot of the screen section that is specified in pixels and 

prints the current view. PrtScr.exe is then closed. "-C=" is always followed by a space. Example: 
PrtScr.exe -C= 50;50;100;100 

-l Prints in landscape format. 
You can add the parameter to any parameter combination.
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Parameters Function
-infinit Serves as parameter for starting PrtScr.exe on a system without WinCC. Always use the parameter 

in combination with "hotkey". 
-hotkey="x" Specifies the key combination that starts output to the printer.

The following characters and combinations are allowed: 
<ALT>, <SHIFT>,<CTRL> +  {0-9, A-Z, 0xXX}
Write the parameters in uppercase letters. Combinations of the <ALT>, <SHIFT>, and <CTRL> 
keys are allowed but not mandatory. 
You can specify the "Virtual Key Code" with "XX" using the hexadecimal input "0xXX". For more 
information about "Virtual Key Codes", refer to the MSDN Library. 
Example: 
"CTRL" and P key combination: -hotkey="<CTRL>+P"      
Print button ("Print-Screen"): -hotkey="0x2C" 
Key combination "ALT" and "Print-Screen": -hotkey="<ALT>+0x2C"    

Examples of parameter combinations

Starting the hardcopy function by means of a key combination  
PrtScr.exe –infinit –hotkey="<ALT>+p"
Enter the following string in the command line:
"C:\Program Files\Common Files\Siemens\BIN\PrtScr.exe" –
infinit –hotkey="<ALT>+p"

Starts PrtScr.exe and waits for input of the "<ALT>+p" key 
combination. The current screen view is printed as 
screenshot when you hit the key combination.

PrtScr.exe –infinit –hotkey="<ALT>+p" –C= 10;10;100;100 Starts PrtScr.exe and waits for input of the "<ALT>+p" key 
combination. Only the screen section that is defined in pixels 
will be printed as screenshot when you hit the key 
combination.

Starting the hardcopy function by means of script  
PrtScr.exe –nomcp Starts PrtScr.exe. Generates a screenshot and prints the 

current view. PrtScr.exe is then closed.
PrtScr.exe –C= 10;10;100;100 Starts PrtScr.exe. Generates a screenshot of the section that 

is specified in pixels and prints the current view. PrtScr.exe 
is then closed.
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4.5 Installation of the WinCC Plug-In Builder

4.5.1 Overview of the WinCC Plug-In Builder

Introduction             
Use the WinCC Plug-In Builder to create a setup program for the download of additional 
components to the WebNavigator Clients, e.g. ActiveX Controls you created. Users can 
download the plug-ins by using the Web Navigation interface, for example. 

Using the Plug-In Builder does not require any knowledge of setup technology or other 
development programs. The Plug-In Setup that is created is available in a self-extracting "EXE" 
file. The file is made available in a folder on the WebNavigator Server for download to the 
clients. 

A WebNavigator plug-in is automatically integrated into an installed WebNavigator Client and 
is also uninstalled along with this client.

The setup programs created with the Plug-In Builder can only be used in the WebNavigator 
environment.

Installing the WinCC Plug-In Builder
1. Install the WinCC Plug-In Builder from the WinCC DVD. Setup will start automatically after 

a few seconds, provided that autorun functionality is not disabled.
Run Setup manually when installing from a network drive or if autorun is disabled. For 
manual setup, go to the Windows Start menu, select "Settings > Control Panel > Software" 
and click on the "Add new programs" icon. Then select the desired installation medium.

2. Select the "User" characteristic in the "Installation scope" dialog.

3. Select installation from WinCC/WebNavigator Plug-In Builder. The Setup program starts.

4. Click "Next" and follow the instructions on the screen. The WinCC/WebNavigator Plug-In 
Builder is installed.

WinCC/WebNavigator Documentation
4.5 Installation of the WinCC Plug-In Builder

WinCC/WebNavigator
System Manual, 07/2013, A5E32316269-AB 141



User interface of WinCC Plug-In Builder
The Plug-In Builder provides an overview of the available plug-in projects and their status.

Toolbars provide the functions for creating and testing plug-ins. The arrangement of the 
toolbars from left to right corresponds to the steps of creating a new plug-in.

The "Installed Web Navigator Software" field displays the WebNavigator components that are 
installed on the computer. Various functions of the Plug-In Builder are only available for certain 
WebNavigator components.  
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4.5.2 How to make plug-ins available for download

Introduction   
After startup, the Plug-In Builder checks the Builder version of the plug-ins already created on 
the computer. The installation of a new version of Plug-In Builder renders any older plug-ins 
void. You have to re-generate these plug-ins.

All plug-ins that are void or not yet generated are displayed in a list at the startup of Plug-In 
Builder.

You can enter the commands in the Plug-In Builder via the menu, the toolbar or the keyboard.

Requirement
● The "Test Plug-In" function requires the WebNavigator Client.

● The "Export Plug-In" function requires the WebNavigator Server.

Creating a Plug-In
1. Start Plug-In Builder in the Windows Start menu by selecting "SIMATIC>WinCC>Web 

Navigator>Web Navigator Plug-In Builder". Click "Next".

2. Click the "New Plug-In" icon on the toolbar.
Enter the plug-in version data in the "New Plug-In" dialog. Do not use umlauts (ä, ü etc.).
Click "OK". On successful creation, the project is displayed in the "Plug-In Projects" field.
Select the "Template" project from the "Plug-In Projects" window if you want to derive the 
information from a template.
Click the "Modify Plug-In" icon on the toolbar. The template is displayed but cannot be 
edited.

3. Click the "Files" icon on the toolbar. The "Files" dialog opens in which to select the files 
integrated in the plug-in.
In the area "Source Path", select the drive and the path in which the desired files are located.
You can copy the files with drag-and-drop to the "Common Files" and "Common Files 
registered" windows. Copy the self-registering files to the "Common Files registered" 
window and any other files to the "Common Files" window.
Remove a file by dragging it to the recycle bin on the bottom edge of the dialog.
Click the "OK" button.

 

  Note

The "Common Files registered" window can only store self-registering files (*.EXE, *.OCX, 
*.DLL). Other files are rejected by the Plug-In Builder. It is not checked whether or not the 
files saved are self-registering.

Under certain circumstances, the integrated files may cause registration problems during 
the subsequent plug-in installation, because the file executes the registration function 
independently. The user is responsible for the correct registration.
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4. Select the newly created plug-in project from the project list. Click the "Build Plug-In" icon 
on the toolbar.
Click "Start" to begin the file generation.
On successful completion of the generation, click "Logfile" to view the associated log file.
Close the dialog with "OK". Successful completion of the generation is indicated by the 
"Build done" entry in the "Build Status" field.

5. Click the "Test Plug-In" icon on the toolbar to test the plug-in.
Click "Install" to start the test installation.
Close the dialog with "OK". Completion of the test is indicated by a "Setup completed" entry 
in the "Status" field.

6. Click the "Publish Plug-In" icon on the toolbar  to publish the plug-in to the WebNavigator 
Server.
If WebNavigator Server and Plug-In Builder are located on the same computer, you can 
export the plug-in directly to the WebNavigator Server. Transfer the plug-in manually to the 
WebNavigator Server if Plug-In Builder is hosted on a different computer.
Start publishing with the "Publish" button. The plug-in you created is saved to the installation 
folder on the WebNavigator Server under:
"WebNavigator/Server/Web/Install/Custom".
Close the dialog with "OK".

7. Close the Plug-In Builder by clicking the "Exit" icon on the toolbar.

Installing plug-ins on the WebNavigator Client
You need Windows administrator rights to install plug-ins created with Plug-In Builder on the 
WebNavigator Client. The Plug-In Builder used and the WebNavigator Client must be of the 
same version.

Install the plug-in using the Web Navigation interface. Select the "Load Plug-Ins" command 
from the "Download area" menu to select the desired plug-in.
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4.6 Configuring terminal services for WebNavigator

4.6.1 Communication Using Terminal Services

Introduction         
In order to use the "Download area" in WebNavigator Client as Terminal Client, do not use a 
proxy server between the Terminal Server and WebNavigator Server.

If the Terminal Server and WebNavigator Server are not installed on the same computer, the 
WebNavigator Client cannot use the terminal services to access the WebNavigator Server. 
You have the following options for countering this problem: 

● A minimum installation of WinCC without licenses is installed on the Terminal Server.

● After installation of the WebNavigator Client, the "CCEClient_service.vbs" file is executed 
once on the Terminal Server. The file is available in the "Updates\WebNavigator" folder on 
your WinCC DVD. You must be logged on with Windows Administrator rights to execute 
the VBS file.

Access from WebNavigator Clients and WinCC Clients to the WebNavigator Server
When a WebNavigator Client via the terminal service and WinCC Clients access the 
WebNavigator Server, the WebNavigator Client operating as Terminal Client must not open a 
Windows Desktop in the session. 

You have the following options of preventing the WebNavigator Client from opening the 
Windows Desktop at the beginning of a session:

● Enter all users directly in the Terminal Service configuration.

● In the Computer Management, enter Internet Explorer as start program for individual users.

4.6.2 Terminal Services Setup

Introduction     
The following chapters show you how to set up the terminal services with regard to the 
WebNavigator Client.

Requirement
● The WinCC basic system and WebNavigator Server do not run under the terminal services.

● The WinCC basic system and WebNavigator Server must be installed on the server before 
you activate the terminal services for the following configuration steps.  
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Configuration steps
1. Activate the terminal services on the Terminal Server

2. Install the application on the Terminal Server, e.g. the WebNavigator Client. Information 
pertaining to the installation can be found in the corresponding documentation and the 
Online Help.

3. On the Terminal Server, create the users for access via the terminal services.

4. Run the application on the Terminal Client.

For more information, refer to "Terminal services" in the Microsoft Online Help.

4.6.3 Activating terminal services on the Windows Server

Introduction     
Activate the Terminal Services on the server before you install the actual applications, e.g. 
WebNavigator Client. 

Install the application on the server using the "Add or Remove Programs" dialog in the Control 
Panel. This makes it possible for all users to configure the applications. If the application is 
installed in any other way, only the user who actually installed the application can use it.

Requirement 
● Windows administrator rights

● Windows server

Procedure 
1. Open the Control Panel and double-click "Software".

2. Click "Add/Remove Windows Components" in the "Software" dialog. The "Windows 
Components Wizard" opens.

3. Activate "Terminal Server" and "Terminal Server Licensing".

4. Click "Next". Follow the instructions.

4.6.4 Creating users for access to the Terminal Server

Requirement     
● Terminal Server is installed.

● A Windows user is created.
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Procedure
1. Open Computer Management via the Control Panel. Select "Local Users and Groups".

2. Double-click the "Users" folder.

3. Double-click the user to be granted access to the Terminal Service.

4. Click on the "Membership" tab. Click "Add". The "Select Group" dialog opens.

5. Add the "Remote Desktop Users" group. Click "OK" to close all open dialogs.

6. Check the membership of the users in other groups. If required, add the user to other groups 
in order to assign the necessary user authorizations.

7. Close Computer Management.

 

4.6.5 Starting the Terminal Server on the Terminal Client

Requirement     
● The Terminal Service is started on the Windows Server

● On the Terminal Server, you created a user for access.

Procedure
1. On the Terminal Client, select "Programs > Accessories > Communication > Remote 

Desktop Connection" in the Windows start menu. The "Remote Desktop Connection" dialog 
opens.

2. Enter the name of the Terminal Server.

3. Click "Connect". Log on with the user that you created for access to the Terminal Server.

Result
The connection is established. The desktop of the Terminal Server is displayed. Start an 
application on the Terminal Server, for example, WebNavigator Client via Internet Explorer.
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4.7 Appendix

4.7.1 Troubleshooting

Communication between the WebNavigator Server and WebNavigator Client is down     
If a provider (participating proxy, Firewall) has set Content Filtering for an Internet connection, 
WebNavigator communication is no longer possible. With content filtering, only certain 
contents of HTML pages are permitted. Communication is routed via a defined port to an IP 
address, e.g. the address of the WinCC Server.

Disable Smart Filtering of the IP address on the WebNavigator Server. Because there is no 
HTML content on the WinCC server, filtering is not particularly useful in any case.

The data is transferred in encrypted form if you are using SSL technology. in this case, Smart 
Filtering of contents is not possible.

Connection abort
In the Internet environment, connection failures, delays, and fluctuation in communication can 
occur. 

If communication between the WebNavigator Client and WebNavigator Server goes down, a 
message is output to the user on the WebNavigator Client. The WebNavigator Client then 
attempts to perform an automatic connection setup in order to restore the connection. 

Set the waiting times between connection attempts with the "Web Configurator". If the value 
"0" is set, the WebNavigator Client does not attempt to reconnect automatically. In this case, 
a message is output on the WebNavigator Client querying whether you wish to re-establish 
the connection. 

Confirm this prompt to re-establish the connection.

No pictures are displayed.
Check that the correct web page is activated on the WebNavigator Server.
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Multiple tab browsing
You need the "ControlHost.exe" process to enable multiple tab browsing in Internet Explorer. 

When you append "?inplacecontrol=no" to the server name in the address bar, the 
WebNavigator Client is no longer hosted in the ControlHost, but instead in Internet Explorer. 
This means that multiple tab browsing is no longer possible and that the "Multiple viewer 
instance disabled" message is output.

Demo mode
If a required license is missing on the WebNavigator Server, a message is displayed informing 
you of this and the WebNavigator Client runs in demo mode. In this mode, the WebNavigator 
Client is fully operational for a period of 30 days. After 30 days, the error message "Still no 
License on Server, Demo mode expired" is shown. The WebNavigator Client can no longer 
connect to the WebNavigator Server.

Security levels as of Internet Explorer 8
Protected mode is activated by default for Internet Explorer 8 in Windows 7. 

While protective mode is activated, you cannot connect to the WebNavigator Server. The error 
message "Low integrity level is not supported:. Please deactivate protected mode" is displayed.

Disable the mode in "Tools > Internet Options > Security". 

No connection to WebNavigator Server possible.
The following section lists several error messages and reasons that prevent the WebNavigator 
Client from connecting to the WebNavigator Server:

● "The WinCC Server is currently not active":
A server is not started in Runtime.

● "Unknown user name or password":
This error can only occur in WinCCViewerRT. The user or password was stored or entered 
incorrectly. Internet Explorer allows you to enter the user name and password three times. 
The "HTTP Error 401.1" error page is then displayed.

 

  Note

Passwords are case-sensitive.
 

● "Maximum count of users reached":
The WinCC/WebNavigator license was exceeded on the WebNavigator Server.

● "Server workload exceeds limit":
The maximum number of simultaneous connections was exceeded. You make the setting 
in "WebNavigator > Web settings > Runtime" in WinCC Explorer. The number of clients 
connected to a server is shown on the page "http://<servername>/status.html". The number 
of simultaneous connections could exceed the number of connected clients if, for example, 
several tabs are opened in the browser window. 
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● "Maximum count of tabs reached":
The maximum number of tabs per browser was exceeded. You make the setting in 
"WebNavigator > Web settings > Runtime" in WinCC Explorer.

● "No connection to server":
The server cannot be reached. The precise cause of error is unknown. For diagnostics 
information, refer to the page "http://<servername>/status.html".

● "Failed to load http://<servername>/Pictures/For_example.PD_":
Access to the configured start picture has failed. Check the authorizations on the 
WebNavigator Server. The published picture may no longer be available on the server.

Wrong start picture
You have edited a new picture in the Graphics Designer.

1. Start the Web View Publisher in order to publish the new picture.

2. Select "Tools > Internet Options" in Internet Explorer to delete the temporary Internet files.

3. You can assign an individual start picture to each user in the User Administration.

See also
Check the activated web page (Page 114)

4.7.2 Functions

4.7.2.1 Supported functions

Introduction
The following list shows the functions supported by WebNavigator. 

Functions not included in this list are not automatically enabled for the WebNavigator.

Functions             

WaitForDocumentReady  

Get_Focus GetTagChar
GetAssignments GetTagCharState
GetBasePicture GetTagCharStateWait
GetFlashPicture GetTagCharWait
GetFontName GetTagMultiStateWait
GetInputValueChar GetTagMultiWait
GetLastChange GetText
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GetOutputFormat SetTagMultiWait
GetOutputValueChar SetTagMultiStateWait
GetPictureName SetTagRaw
GetPropChar SetTagRawState
GetServerName SetTagRawStateWait

 

AXC_OnBtnArcLong AXC_OnBtnMsgNext
AXC_OnBtnArcShort AXC_OnBtnMsgPrev
AXC_OnBtnComment AXC_OnBtnMsgWin
AXC_OnBtnEmergAckn AXC_OnBtnScroll
AXC_OnBtnInfo AXC_OnBtnSelect
AXC_OnBtnLock AXC_OnBtnSinglAckn
AXC_OnBtnLoop AXC_OnBtnVisibleAckn
AXC_OnBtnMsgFirst AXC_SetFilter
AXC_OnBtnMsgLast  

 

OnBtnArcLong OnBtnMsgLast
OnBtnArcShort OnBtnMsgNext
OnBtnComment OnBtnMsgPrev
OnBtnEmergAckn OnBtnMsgWin
OnBtnHornAckn OnBtnPrint
OnBtnInfo OnBtnScroll
OnBtnLanguage OnBtnSelect
OnBtnLock OnBtnSinglAckn
OnBtnLoop OnBtnVisibleAckn
OnBtnMsgFirst  

 

TLGGetTemplateParameter TlgTableWindowPressPrevButton
TLGPressToolbarButton TlgTableWindowPressPrevItemButton
TlgGetColumnPosition TlgTableWindowPressStartStopButton
TlgGetNumberOfColumns TlgTrendWindowPressFirstButton
TlgGetNumberOfRows TlgTrendWindowPressLastButton
TlgGetNumberOfTrends TlgTrendWindowPressLinealButton
TlgGetRowPosition TlgTrendWindowPressNextButton
TlgGetRulerArchivNameTrend TlgTrendWindowPressNextItemButton
TlgGetRulerTimeTrend TlgTrendWindowPressOneToOneButton
TlgGetRulerValueTrend TlgTrendWindowPressOpenArchiveVariableSelectionDlgBut

ton
TlgGetRulerVariableNameTrend TlgTrendWindowPressOpenDlgButton
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TlgGetTextAtPos TlgTrendWindowPressOpenItemSelectDlgButton
TlgTableWindowPressFirstButton TlgTrendWindowPressOpenTimeSelectDlgButton
TlgTableWindowPressLastButton TlgTrendWindowPressPrevButton
TlgTableWindowPressNextButton TlgTrendWindowPressPrevItemButton
TlgTableWindowPressNextItemButton TlgTrendWindowPressStartStopButton
TlgTableWindowPressOpenArchiveVariableSelectionDlgBut
ton

 TlgTrendWindowPressZoomInButton

TlgTableWindowPressOpenItemSelectDlgButton TlgTrendWindowPressZoomOutButton
TlgTableWindowPressOpenTimeSelectDlgButton  

 

GetLanguage GetParentPicture
SetLanguage GetParentPictureWindow
GetLink GetServerTagPrefix
SetLink OpenPicture
GetLinkedVariable SetPictureDeactivated
GetLocalPicture SetPictureDown
SetMultiLink SetPictureUp

 

_makepath fscanf setvbuf
_splitpath fsetpos sprintf 
abs ftell srand
abort fwrite sscanf 
asctime getc strcat
atexit  getchar strcmp
atof getenv strcpy
atoi gets strchr
atol gmtime strcspn
bsearch labs strerror
calloc ldiv strftime
clearerr localtime strlen
clock malloc strncat 
ctime memchr strncmp
difftime memcmp strncpy
div memcpy strpbrk
exit memmove strrchr
fclose memset strspn
feof mktime strstr
ferror perror strtod
fflush printf strtok
fgetc putc strtol
fgetpos putchar strtoul
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 fgets puts SysMalloc
fopen qsort system
fprintf rand time
fputc realloc  ungetc
fputs  remove vfprintf
freopen rename vprintf 
fread rewind vsprintf
free scanf  
fseek setbuf  

 

Check ProgramExecute

 

GetActualPointLeft GetExponent GetPicDeactTransparent
GetActualPointTop GetExtendedOperation GetPicDeactUseTransColor
GetAdaptBorder GetFillColor GetPicDownReferenced
GetAdaptPicture GetFilling GetPicDownTransparent
GetAdaptSize GetFillingIndex GetPicDownUseTransColor
GetAlarmHigh GetFillStyle GetPicReferenced
GetAlarmLow GetFillStyle2 GetPicTransColor
GetAlignment GetFlashBackColor GetPicUpReferenced
GetAlignmentLeft GetFlashBorderColor GetPicUpTransparent
GetAlignmentTop GetFlashFlashPicture GetPicUpUseTransColor
GetAssumeOnExit GetFlashForeColor GetPicUseTransColor
GetAssumeOnFull GetFlashPicReferenced GetPictureDeactivated
GetAverage GetFlashPicTransColor GetPictureDown
GetAxisSection GetFlashPicUseTransColor GetPictureUp
GetBackBorderWidth GetFlashRateBackColor GetPointCount
GetBackColor GetFlashRateBorderColor GetPosition
GetBackColor2 GetFlashRateFlashPic GetPressed
GetBackColor3 GetFlashRateForeColor GetProcess
GetBackColorBottom GetFontBold GetPropBOOL
GetBackColorTop GetFontItalic GetPropDouble
GetBackFlashColorOff GetFontSize GetPropLong
GetBackFlashColorOn GetFontUnderline GetPropWord
GetBasePicReferenced GetForeColor GetRadius
GetBasePicTransColor GetForeFlashColorOff GetRadiusHeight
GetBasePicUseTransColor GetForeFlashColorOn GetRadiusWidth
GetBitNumber GetGrid GetRangeMax
GetBorderBackColor GetGridColor GetRangeMin
GetBorderColor GetGridHeight GetReferenceRotationLeft
GetBorderColorBottom GetGridWidth GetReferenceRotationTop
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GetBorderColorTop GetHeight GetRightComma
GetBorderEndStyle GetHiddenInput GetRotationAngle
GetBorderFlashColorOff GetHotkey GetRoundCornerHeight
GetBorderFlashColorOn GetHysteresis GetRoundCornerWidth
GetBorderStyle GetHysteresisRange GetScaleColor
GetBorderWidth GetIndex GetScaleTicks
GetBoxAlignment GetInputValueDouble GetScaling
GetBoxCount GetItemBorderBackColor GetScalingType
GetBoxType GetItemBorderColor GetScrollBars
GetButtonColor GetItemBorderStyle GetSelBGColor
GetCaption GetItemBorderWidth GetSelTextColor
GetCheckAlarmHigh GetLanguageSwitch GetSizeable
GetCheckAlarmLow GetLayer GetSmallChange
GetCheckLimitHigh4 GetLeft GetStartAngle
GetCheckLimitHigh5 GetLeftComma GetToggle
GetCheckLimitLow4 GetLimitHigh4 GetToleranceHigh
GetCheckLimitLow5 GetLimitHigh5 GetToleranceLow
GetCheckToleranceHigh GetLimitLow4 GetTop
GetCheckToleranceLow GetLimitLow5 GetTrend
GetCheckWarningHigh GetLimitMax GetTrendColor
GetCheckWarningLow GetLimitMin GetTypeAlarmHigh
GetClearOnError GetListType GetTypeAlarmLow
GetClearOnNew GetLongStrokesBold GetTypeLimitHigh4
GetCloseButton GetLongStrokesOnly GetTypeLimitHigh5
GetColorAlarmHigh GetLongStrokesSize GetTypeLimitLow4
GetColorAlarmLow GetLongStrokesTextEach GetTypeLimitLow5
GetColorBottom GetMarker GetTypeToleranceHigh
GetColorChangeType GetMax GetTypeToleranceLow
GetColorLimitHigh4 GetMaximizeButton GetTypeWarningHigh
GetColorLimitHigh5 GetMin GetTypeWarningLow
GetColorLimitLow4 GetMoveable GetUnselBGColor
GetColorLimitLow5 GetNumberLines GetUnselTextColor
GetColorToleranceHigh GetOffsetLeft GetUpdateCycle
GetColorToleranceLow GetOffsetTop GetVisible
GetColorTop GetOnTop GetWarningHigh
GetColorWarningHigh GetOperation GetWarningLow
GetColorWarningLow GetOperationMessage GetWindowBorder
GetCursorControl GetOperationReport GetWindowsStyle
GetDataFormat GetOrientation GetWidth
GetDirection GetOutputValueDouble GetZeroPoint
GetEditAtOnce GetPasswordLevel GetZeroPointValue
GetEndAngle GetPicDeactReferenced GetZoom
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Set_Focus SetEditAtOnce SetPicDownUseTransColor
SetActualPointLeft SetEndAngle SetPicTransColor
SetActualPointTop SetExponent SetPicUpTransparent
SetAlarmHigh SetExtendedOperation SetPicUpUseTransColor
SetAlarmLow SetFillColor SetPicUseTransColor
SetAlignment SetFilling SetPictureName
SetAlignmentLeft SetFillingIndex SetPointCount
SetAlignmentTop SetFillStyle SetPosition
SetAssumeOnExit SetFillStyle2 SetPressed
SetAssumeOnFull SetFlashBackColor SetProcess
SetAverage SetFlashBorderColor SetPropBOOL
SetAxisSection SetFlashFlashPicture SetPropChar
SetBackBorderWidth SetFlashForeColor SetPropDouble
SetBackColor SetFlashPicTransColor SetPropLong
SetBackColor2 SetFlashPicUseTransColor SetPropWord
SetBackColor3 SetFlashRateBackColor SetRadius
SetBackColorBottom SetFlashRateBorderColor SetRadiusHeight
SetBackColorTop SetFlashRateFlashPic SetRadiusWidth
SetBackFlashColorOff SetFlashRateForeColor SetRangeMax
SetBackFlashColorOn SetFontBold SetRangeMin
SetBasePicTransColor SetFontItalic SetRightComma
SetBasePicUseTransColor SetFontName SetReferenceRotationLeft
SetBitNumber SetFontSize SetReferenceRotationTop
SetBorderBackColor SetFontUnderline SetRotationAngle
SetBorderColor SetForeColor SetRoundCornerHeight
SetBorderColorBottom SetForeFlashColorOff SetRoundCornerWidth
SetBorderColorTop SetForeFlashColorOn SetScaleColor
SetBorderEndStyle SetHeight SetScaleTicks
SetBorderFlashColorOff SetHiddenInput SetScaling
SetBorderFlashColorOn SetHysteresis SetScalingType
SetBorderStyle SetHysteresisRange SetSelBGColor
SetBorderWidth SetIndex SetSelTextColor
SetBoxAlignment SetItemBorderBackColor SetSmallChange
SetBoxCount SetItemBorderColor SetStartAngle
SetBoxType SetItemBorderStyle SetText
SetButtonColor SetItemBorderWidth SetTop
SetCheckAlarmHigh SetLeft SetTrend
SetCheckAlarmLow SetLeftComma SetTrendColor
SetCheckLimitHigh4 SetLimitHigh4 SetToleranceHigh
SetCheckLimitHigh5 SetLimitHigh5 SetToleranceLow
SetCheckLimitLow4 SetLimitLow4 SetToggle
SetCheckLimitLow5 SetLimitLow5 SetTypeAlarmHigh
SetCheckToleranceHigh SetLimitMax SetTypeAlarmLow
SetCheckToleranceLow SetLimitMin SetTypeLimitHigh4
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SetCheckWarningHigh SetLongStrokesBold SetTypeLimitHigh5
SetCheckWarningLow SetLongStrokesOnly SetTypeLimitLow4
SetClearOnError SetLongStrokesSize SetTypeLimitLow5
SetClearOnNew SetMarker SetTypeToleranceHigh
SetColorAlarmHigh SetMax SetTypeToleranceLow
SetColorAlarmLow SetMin SetTypeWarningHigh
SetColorBottom SetNumberLines SetTypeWarningLow
SetColorChangeType SetOffsetLeft SetUnselBGColor
SetColorLimitHigh4 SetOffsetTop SetUnselTextColor
SetColorLimitHigh5 SetOperation SetVisible
SetColorLimitLow4 SetOperationMessage SetWarningHigh
SetColorLimitLow5 SetOperationReport SetWarningLow
SetColorToleranceHigh SetOrientation SetWindowsStyle
SetColorToleranceLow SetOutputValueChar SetWidth
SetColorTop SetOutputValueDouble SetZeroPoint
SetColorWarningHigh SetPasswordLevel SetZeroPointValue
SetColorWarningLow SetPicDeactTransparent SetZoom
SetCursorControl SetPicDeactUseTransColor  
SetDirection SetPicDownTransparent  

 

GetTagBit GetTagFloatState GetTagSWordWait
GetTagByte GetTagRawState GetTagWordWait
GetTagDouble GetTagSByteState GetTagBitStateWait
GetTagDWord GetTagSDWordState GetTagByteStateWait
GetTagFloat GetTagSWordState GetTagDoubleStateWait
GetTagRaw GetTagWordState GetTagDWordStateWait
GetTagSByte GetTagBitWait GetTagFloatStateWait
GetTagSDWord GetTagByteWait GetTagRawStateWait
GetTagSWord GetTagDoubleWait GetTagSByteStateWait
GetTagWord GetTagDWordWait GetTagSDWordStateWait
GetTagBitState GetTagFloatWait GetTagSWordStateWait
GetTagByteState GetTagRawWait GetTagWordStateWait
GetTagDoubleState GetTagSByteWait  
GetTagDWordState GetTagSDWordWait  

 

SetTagBit SetTagFloatState SetTagSWordWait
SetTagByte SetTagRawState SetTagWordWait
SetTagDouble SetTagSByteState SetTagBitStateWait
SetTagDWord SetTagSDWordState SetTagByteStateWait
SetTagFloat SetTagSWordState SetTagDoubleStateWait
SetTagRaw SetTagWordState SetTagDWordStateWait
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SetTagSByte SetTagBitWait SetTagFloatStateWait
SetTagSDWord SetTagByteWait SetTagRawStateWait
SetTagSWord SetTagDoubleWait SetTagSByteStateWait
SetTagWord SetTagDWordWait SetTagSDWordStateWait
SetTagBitState SetTagFloatWait SetTagSWordStateWait
SetTagByteState SetTagRawWait SetTagWordStateWait
SetTagDoubleState SetTagSByteWait  
SetTagDWordState SetTagSDWordWait  

Supported ODK Functions
PWRTCheckPermission  

PWRTCheckPermissionOnPicture // Only the "permlevel" parameter is evaluated! 

MSRTStartMsgService  

MSRTStopMsgService  

MSRTCreateMsg  

MSRTCreateMsgInstanceWithComment

MSRTSetComment

PDLRTGetLink

PDLRTSetLink

PDLRTSetMultiLink

PDLRTGetPropEx // Nur das Lesen wird unterstützt.

PDLRTSetPropEx // Nur das Setzen wird unterstützt.

TXTRTConnect

TXTRTDisconnect

TXTRTGetInfoTextMC

Unterstützte User Archive-Funktionen
 

 Note

User archive functions must always start with "ua" in lower case. 

Functions beginning with the uppercase letters "UA" are ODK functions. These ODK functions 
are not supported on the WebNavigator Client.

 

uaArchiveClose uaArchiveGetName uaArchiveSetFieldValueLong
uaArchiveDelete uaArchiveGetSort uaArchiveSetFieldValueString
uaArchiveExport uaArchiveImport uaArchiveSetFilter
uaArchiveGetCount uaArchiveInsert uaArchiveSetSort
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uaArchiveGetFieldLength uaArchiveMoveFirst uaArchiveUpdate
uaArchiveGetFieldName uaArchiveMoveLast uaArchiveWriteTagValues
uaArchiveGetFields uaArchiveMoveNext uaArchiveWriteTagValuesByName
uaArchiveGetFieldType uaArchiveMovePrevious uaConnect
uaArchiveGetFieldValueDate uaArchiveOpen uaDisconnect
uaArchiveGetFieldValueFloat uaArchiveReadTagValues uaGetLastError
uaArchiveGetFieldValueDouble uaArchiveReadTagValuesByName uaGetLastHResult
uaArchiveGetFieldValueLong uaArchiveRequery uaQueryArchive
uaArchiveGetFieldValueString uaArchiveSetFieldValueDate uaQueryArchiveByName
uaArchiveGetFilter uaArchiveSetFieldValueDouble uaReleaseArchive
uaArchiveGetID uaArchiveSetFieldValueFloat  

Supported MBCS Functions

_ismbcalnum _mbscat _mbsncmp
_ismbcalpha _mbschr _mbsncpy
_ismbcdigit _mbscmp _mbsnicmp
_ismbcgraph _mbscpy _mbspbrk
_ismbclower _mbsdec _mbsrchr
_ismbcprint _mbsicmp _mbsspn
_ismbcpunct _mbsinc _mbsstr
_ismbcspace _mbslen _mbstok
_ismbcupper _mbscspn _mbctolower
_mbclen _mbsncat _mbctoupper

4.7.2.2 WaitForDocumentReady

Function     
The function checks whether a picture is loaded in the specified picture window.

A difference must be made in the scripts of process pictures or project functions between the 
runtime environment of WinCC and of the WebNavigator Client. The following Compiler 
commands exist to this purpose:

● #ifdef RUN_ON_WEBNAVIGATOR

● #ifndef RUN_ON_WEBNAVIGATOR

This allows you to distinguish between WinCC and the WebNavigator Client in your 
configuration as follows:

● Script delay with "WaitForDocumentReady"

● Differing picture addressing

● Different function names for control system functions

● Functions that are not supported on the WebNavigator Client
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Syntax in ANSI-C
int WaitForDocumentReady(LPCSTR lpszPictureWindow)

Parameters

lpszPictureWindow
Pointer to the name of the picture window that is opened in the WebNavigator Client.

The following addressing syntax is possible:

● Picture window "xxx" in the current screen: ./xxx
● Picture window "yyy" in the view object "xxx": ./xxx/yyy
● Picture window "xxx" in the parent screen: ../xxx
● Picture window "xxx" in the parent picture of the parent screen: ../../xxx
● Absolute path compatible with WinCC

Return value

TRUE
The picture window has been found and the status checked.

FALSE
The picture window has not been found.

Example of ANSI-C
#ifdef RUN_ON_WEBNAVIGATOR
SetPropChar("../", "View", "PictureName", szViewName);
WaitForDocumentReady("../View");
#else
SetPropChar(lpszParent, "View", "PictureName", szViewName);
#endif

 

 Note

The syntax of the code section for WebNavigator is not checked during compilation of the 
WinCC script and is checked only when the pictures are published.

 

VBScript syntax
Sub WaitForDocumentReady(Byref PictureWindow)
On Error Resume Next
Err.Clear
Dim state 
state = PictureWindow.DocumentState
If Err.Number = 0 Then
 While state = 1 ' Loading
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 'HMIRuntime.Trace "DocumentState = " & state
 state = PictureWindow.DocumentState
 Wend
End If
End Sub

Example of VBScript
Sub OnClick(ByVal Item) 
Dim window 
Set window = HMIRuntime.ActiveScreen.ScreenItems("PictureWindow2")
window.Visible = True
WaitForDocumentReady window
End Sub

4.7.2.3 Unsupported Functions
The following list is only an extract of the unsupported functions. The list contains the functions 
that are explicitly stated as being unsupported. 

Functions     

GetHWDiag OnDeactivateExecute ReportJob
GetHWDiagLevel OnErrorExecute RPTJobPreview
GetKopFupAwl OnTime RPTJobPrint
GetKopFupAwlLevel OpenPrevPicture RptShowError 

VBScript functions
● HMIRuntime.Stop: Terminates Internet Explorer and WinCCViewerRT, but not WinCC 

Runtime.

● AlarmLogs Object

● DataLogs Object

● Logging Object

● Project Object

Functions That Are not Required:
● DeactivateRTProject: Terminates Internet Explorer and WinCCViewerRT, but not WinCC 

Runtime.

● ExitWinCC

● FillDiagnoseInTags

● InquireLanguage

● TraceText

● TraceTime
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Other Functions
These functions are included in the functional scope in order to ensure error-free compilation 
on the WebNavigator Client. The functions are not supported by the WebNavigator Client.

AXC_OnBtnHornAckn GetCursorMode GmsgFunction  
AXC_OnBtnPrint SetCursorMode MSRTMsgWinCommand
AXC_OnBtnProtocol  TlgTableWindowPressHelpButton
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Index

 
 Diagnostics

WebNavigator Server, 132
 Error report , (See support)
 Internet Information Service, 103
 License, 10
 Web Client, (See WebNavigator client)
 Web Configurator, 103

 Creating the standard web page, 105
 Setting up the Internet Information Service, 103
Creating a virtual directory, 107
Setting the port, 105

 WebNavigator
DVD contents, 7
Licenses, 10

 WebNavigator client, 8
Licenses, 10

 WebNavigator Diagnostics Client, 82
 WebNavigator Diagnostics Server, 82
 WebNavigator server, 8

Licenses, 10
 WinCC/WebNavigator client, (See WebNavigator 
client)
 WinCC/WebNavigator Diagnostics Client, (See 
WebNavigator Diagnostics Client)

A
ActiveX controls, 141
Authorization

Configuring web options, 100

C
Communication, 78
Configuration, 103
Corrective measure

Connection abort, 148
Customer support, (See support)

D
Dedicated web server, 80

Picture change, 128
Publishing process pictures, 85, 86, 87

Demo Project, 27
Diagnostics client, (See WebNavigator diagnostics 
client)

F
FAQ, (See support), (See corrective measure)
Firewall

Windows 2003, 53, 109
Windows 2008, 58, 113
Windows 7, 58, 113
Windows XP, 53, 109

Function
 Unsupported functions, 160
Opening the picture window, 158
Supported functions, 150
Supported MSBC functions, 150
Supported ODK Functions, 150
Supported User Archives functions, 150

G
Gadget, 96
Getting started, 50, 51, 53, 69, 71

Changing the process picture, 69, 71
Configuring the WebNavigator Server, 51, 53

Global Script
 Use in WebNavigator, 122

H
Hardcopy, 139
Hardware

Requirement, 8

I
IIS, (See Internet Information Service), (See Internet 
Information Service), (See Internet Information 
Service), (See Internet Information Service)
Installation

Internet Information Service, 15
Requirement, 8, 12
Security settings, 23, 61
Upgrade, 16, 18
WebNavigator client, 18, 23, 24
WebNavigator Client, 23, 61
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WebNavigator Diagnostics Client, 26
WebNavigator server, 16

Internet Explorer, 129
Security settings, 23, 61

Internet Explorer V7.0, 30
Online Help, 30

Internet Information Service, 15
Checking the activated web page, 59, 114
Starting a web page, 59, 114

Isolated solution, 77

L
Language-dependent text, 125
License, 7

WebNavigator diagnostics client, 10
WebNavigator diagnostics server, 10

Load Balancing
Configuring, 118

Load balancing , 115
Load distribution, (See Load balancing ), (See Load 
Balancing )

O
Online Help

Internet Explorer V7.0, 30
Online support, (See support)
OPC channel, 78

P
PdlPad, 87
Persistence, 125
Plug-In

Create, (See Plug-In Builder)
Plug-In Builder, 141

Creating a plug-in and making it available for 
download, 143

Port
Setting, 105

Process bus, 78
Process picture, 128

Publishing, 85, 86, 87

R
Remote publishing, 85, 86, 87
Requirement

Hardware, 8

Installation, 8
Operating system, 8
Software, 8

S
Screenshot, (See Hardcopy)
Script

Functions, 158
SIMATIC Logon, 100
Slider Control, 125
Software

Requirement, 8
Software Information Service, 7
Standard web page, 105
Support, 36, 39
Support Request, 39
System authorization, 100

T
Technical support, (See support)
Terminal server, (See terminal services)
Terminal service, 12
Terminal services, 83

activate, 146
Communication, 145
Set up, 145
Setting up users, 146
Start terminal services server, 147

Terminal services client, (See terminal services)
Terminal services server, (See terminal services)

U
Upgrade, 16, 18
User administrator

User administration for WebNavigator, 100
User Administrator

Web options, 100
User change, 63, 134

V
Virtual directory, 107
Visual Basic Script

 Use in WebNavigator, 122
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W
Web Client, (See WebNavigator Client), (See 
WebNavigator Client)
Web Configurator

 Configuring the Firewall, 53, 58, 109, 113
Web Navigation interface, 130, 131
Web option, 100
Web project, 84

Checking scripts with PdlPad, 87
Differences compared to the WinCC basic system, 
124
Mirroring a WinCC project, 78
Publishing process pictures , 85, 86, 87
Restrictions, 121
Using Scripts, 122
Web settings, 95, 99
Web Viewer, 63, 75, 134

Web Publishing Wizard, (See WebPublisher)
Web setting, 95, 99
Web setup, (See Web Configurator)
Web View Publisher, (See WebPublisher)
Web Viewer, 63, 67, 75, 134, 138
WebNavigator

 Restrictions for web projects, 121
 Using Scripts, 122
Configuration steps, 84
Demo Project, 27
Differences compared to the WinCC basic system, 
122, 124
Functions, 150, 160
Gadget, 96
Installation requirements, 8
Load balancing , 115, 118
Pre-processor definition in the scripting, 122
Publishing process pictures , 85, 86, 87
Terminal services, 83, 145, 146, 147
Terminal Services, 145
User administration, 100
Using tags, 124
Web project, 84, 95, 99

WebNavigator client, 23, 24
Installation, 18
Installation under the Windows Server, 18
Upgrade, 18

WebNavigator Client, 75, 125, 129
Access via terminal services, 145
Automatic connection establishment, 125
Automatic logout, 100
Functions, 125
Hardcopy function, 139

Picture change, 124
Picture in picture method, 122
Pictures, 128
Plug-In Builder, 141
Plug-Ins, 141
Web options, 100

WebNavigator diagnostics client, 8
WebNavigator Diagnostics Client, 75

Installation, 26
WebNavigator server

Installation, 16
Upgrade, 16

WebNavigator Server, 75
 Dedicated web server, 80
Checking scripts with PdlPad, 87
Configuration with WinCC server, 77, 78, 80
Diagnostics, 132
Editing the configuration, 103
Initial configuration, 103
Isolated solution, 77
Load balancing , 115, 118

WebPublisher
Checking scripts with PdlPad, 87
Publishing process pictures, 85, 87
Requirements, 86

WinCC client
Access via terminal services, 145

WinCC Plug-In Builder, (See Plug-In Builder)
WinCC project, (See web project), (See web project), 
(See web project)
WinCC server

 Configuration with WebNavigator Server, 77
Configuration with WebNavigator Server, 78

WinCC User Administrator, (See User administrator)
WinCC WebNavigator, (See: WebNavigator)
WinCC/WebNavigator Diagnostics Server, (See 
WebNavigator Diagnostics Server)
WinCC/WebNavigator server, (See WebNavigator 
server)
WinCCViewerRT, 63, 67, 72, 100, 134, 138, (See 
Web Viewer), (See Web Viewer), (See Web Viewer), 
(See Web Viewer), (See Web Viewer)
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